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ApSIC Xbench permite organizar y realizar búsquedas en la terminología 
bilingüe de referencia y, además, ofrece varias funciones de control de 
calidad (QA) para mejorar la calidad de las traducciones. 

Funciones de búsqueda 
ApSIC Xbench permite llevar a cabo búsquedas avanzadas en los 
siguientes formatos bilingües: 

 Archivos de texto delimitado por tabulaciones (*.txt, *.tsv, *.utx) 
 Archivos XLIFF, como memoQ XLIFF, Memsource XLIFF, Idiom 

XLIFF, Translation Workspace XLIFF, XTM XLIFF y otras 
variantes de XLIFF (*.xlf, *.xlif, *.xliff, *.xlz, *.mqxlz, *.mxliff) 

 Memorias en formato TMX (*.tmx) 
 Glosarios en formato TBX/MARTIF (*.xml, *.tbx, *.mtf) 
 Archivos TIPP (*.tipp) 
 Memorias de Trados exportadas (*.txt) 
 Glosarios de Trados MultiTerm 5 exportados (*.txt) 
 Glosarios de Trados MultiTerm (*.xml, *.sdltb, *.mdb) 
 Archivos de Trados TagEditor (*.ttx) 
 Archivos sin limpiar de Word para Trados (*.doc, *.rtf) 
 Archivos de Trados Studio (*.sdlxliff, *.sdlproj) 
 Memorias de Trados Studio (*.sdltm) 
 Archivos de memoQ, incluidos paquetes de envío y de entrega 

(*.mqxlz, *.mqxliff, *.mqout, *.mqback) 
 Bases de datos terminológicas de memoQ en formato CSV  
 Archivos en formato ITD de SDLX (*.itd). Nota: Para esta opción, se 

necesita tener SDLX instalado en el equipo.  
 Memorias de SDLX (*.mdb) 
 Directorios de STAR Transit 2.6/XV/NXT 
 Archivos PO (*.po) 
 Diccionarios de IBM TranslationManager exportados (*.sgm) 
 Carpetas de IBM TranslationManager instaladas y exportadas (*.fxp)  
 Memorias de IBM TranslationManager exportadas (*.exp) 
 Diccionarios de OpenTM2 exportados (*.sgm) 
 Carpetas de OpenTM2 instaladas y exportadas (*.fxp)  
 Memorias de OpenTM2 exportadas (*.exp) 

Descripción general 
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 Memorias de Wordfast (*.txt) 
 Glosarios de Wordfast (*.txt) 
 Archivos de Wordfast Pro (*.txml, *.txlf) 
 Archivos de Idiom/Déjà Vu X, incluidos Satellite y Pack&Go 

(*.wsprj, *.dvprj, *.dvsat, *.dvpng) 
 Memorias de Idiom/Déjà Vu X (*.wstm, *.dvmdb) 
 Bases de datos terminológicas de Déjà Vu X/Idiom (*.wstd, *.dvtdb) 
 Archivos RTF de Logoport (*.rtf) 
 Glosarios de software de Microsoft (*.csv) 
 Glosarios de Mac OS X (*.ad, *.lg) 
 Archivos de Qt Linguist (*.ts) 
 Glosarios de Passolo (*.glo) 
 Proyectos de Transifex 
 Trabajos de Matecat 
 Glosarios de Remote Xbench Server 

La terminología de referencia se puede organizar en varios niveles de 
prioridad para mostrar claramente a los traductores cuáles son las 
preferencias específicas de un proyecto de traducción.  

ApSIC Xbench se ejecuta en un segundo plano y se puede realizar una 
búsqueda del texto marcado utilizando una combinación de teclas válida 
en todo el sistema (de forma predeterminada, Ctrl+Alt+Insert), lo cual 
brinda la posibilidad de una búsqueda terminológica instantánea desde 
cualquier aplicación de Windows mediante una combinación de teclas 
común. 

ApSIC Xbench incluye un motor de búsqueda muy avanzado. No solo se 
puede buscar por texto fuente o meta sino que también se pueden llevar a 
cabo búsquedas negativas o condicionales mediante la función 
PowerSearch (Ctrl+P) o efectuar búsquedas complejas utilizando 
expresiones regulares o caracteres comodín de Microsoft Word.  

Nota: Una vez abierto, ApSIC Xbench permanece en un segundo plano 
hasta que se cierra de manera explícita con el comando Shut Down 
Xbench, disponible con un clic derecho en el icono de la barra de tareas 
de Windows o mediante el menú desplegable Project.  

Funciones de QA 
Al definir los archivos de traducción actuales como traducción en curso 
en un proyecto de ApSIC Xbench, se pueden ejecutar las siguientes 
comprobaciones de control de calidad: 

 Buscar segmentos sin traducir 
 Buscar segmentos con el mismo texto fuente y distinto texto meta 
 Buscar segmentos con el mismo texto meta y distinto texto fuente 
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 Buscar segmentos cuyo texto meta es idéntico al texto fuente (texto 
potencialmente sin traducir) 

 Buscar discrepancias de etiquetas 
 Buscar discrepancias numéricas 
 Buscar discrepancias de URL 
 Buscar discrepancias alfanuméricas 
 Buscar símbolos no emparejados (es decir, paréntesis, corchetes o 

llaves no emparejados) 
 Buscar comillas no emparejadas 
 Buscar dobles espacios 
 Buscar palabras repetidas 
 Buscar palabras en MAYÚSCULAS en el texto fuente sin un 

equivalente idéntico en el texto meta y palabras en MAYÚSCULAS 
en el texto meta sin un equivalente en el texto fuente 

 Buscar palabras en CamelCase en el texto fuente sin un equivalente 
idéntico en el texto meta y palabras en CamelCase en el texto meta 
sin un equivalente en el texto fuente  

 Buscar discrepancias terminológicas respecto a una lista de términos 
clave 

 Ejecutar listas de comprobación definidas por el usuario 
 Corregir la ortografía de las traducciones (requiere la descarga del 

diccionario según el idioma desde Tools->Spell-Checking 
Dictionaries) 

Las listas de comprobación son búsquedas definidas por el usuario que se 
pueden ejecutar en lote contra la traducción en curso. Por ejemplo, con 
las listas de comprobación se pueden buscar palabras prohibidas o errores 
típicos de traducción. 
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Cómo instalar o 
desinstalar ApSIC Xbench 

 

Para instalar 
ApSIC Xbench 

ApSIC Xbench 3.0 está disponible en ediciones de 32 y 64 bits. La 
edición de 32 bits se puede instalar en equipos con Windows de 32 o 64 
bits. La edición de 64 bits solo se puede instalar en equipos de 64 bits. 
ApSIC Xbench es compatible con Windows XP, Windows Vista, 
Windows 7 y Windows 8. También es compatible con Windows 2003 y 
Windows 2008. 

Para instalar ApSIC Xbench, realice estos pasos: 

Ejecute el archivo de instalación (por ejemplo, 
Setup.Xbench.x64.3.0.1080.exe). Aparece la ventana de bienvenida del 
instalador. 

 

C A P Í T U L O  1  
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Haga clic en Next. Aparece la ventana de la licencia. Lea con atención la 
información sobre la licencia para asegurarse de que acepta las 
condiciones. 

Si acepta las condiciones de la licencia, haga clic en I Agree. Si no las 
acepta, haga clic en Cancel. 

 

De ser necesario, cambie la carpeta de destino y haga clic en Install para 
continuar. 

Los archivos se copian al destino seleccionado y aparece la siguiente 
ventana: 

 

Haga clic en Finish para cerrar la ventana y comenzar a utilizar 
ApSIC Xbench. 

Se instala un vínculo al archivo ejecutable de ApSIC Xbench en la ruta 
Inicio->Programas->ApSIC Tools->Xbench, junto con la 
documentación. 
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Para desinstalar 
ApSIC Xbench 

Para desinstalar ApSIC Xbench, realice estos pasos: 

1 Seleccione Inicio->Configuración->Panel de control en la barra de 
tareas de Windows. Vaya al Panel de control de Windows y abra el 
icono Agregar o quitar programas. 

2 Busque ApSIC Xbench 3.0 en la lista y haga clic en el botón 
Cambiar o quitar. 

3 Cuando obtenga el mensaje de confirmación, haga clic en Sí. 

Instalación desatendida 
Se puede llevar a cabo una instalación desatendida de ApSIC Xbench con 
la opción /S de la línea de comandos. 

c:\>Setup.Xbench.x64.3.0.exe /S 

Para especificar un directorio de instalación diferente, se puede hacer con 
la opción /D. 

c:\>Setup.Xbench.x64.3.0.exe /S 
/D=[ruta_del_directorio_de_instalación] 

Se debe tener en cuenta que las opciones /S y /D distinguen mayúsculas y 
minúsculas. 
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Cómo iniciar o cerrar 
ApSIC Xbench 

ApSIC Xbench es una aplicación que, una vez iniciada, se debe cerrar de 
manera explícita si ya no es necesaria. Por lo general, se carga el proyecto 
de referencia para buscar terminología mientras se traduce y queda en un 
segundo plano hasta que se termina el trabajo de traducción. Cerrar la 
ventana de ApSIC Xbench no implica quitar el programa de la memoria 
porque sigue esperando la próxima consulta mediante la secuencia de 
teclas Ctrl+Alt+Insert. 

Cómo iniciar 
ApSIC Xbench 

Para iniciar ApSIC Xbench, realice uno de estos procedimientos: 

 Seleccione Inicio->Programas->ApSIC Tools->Xbench en la barra 
de tareas de Windows. 

 Haga doble clic en el icono de un proyecto de ApSIC Xbench 
previamente definido (con extensión *.xbp). 

Cómo cerrar 
ApSIC Xbench 

Para cerrar ApSIC Xbench, se tienen las siguientes opciones: 

 Haga clic derecho en el icono de ApSIC Xbench (una gema rosa) 
ubicado en la bandeja del sistema y haga clic en Shut Down Xbench. 

 En el menú Project, haga clic en Shut Down Xbench. 
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Cómo registrarse para 
usar ApSIC Xbench 

El sistema de licencia de ApSIC Xbench requiere que los usuarios se 
registren con su cuenta de correo electrónico. Al iniciar Xbench por 
primera vez, aparece el cuadro de diálogo Sign In. 

 

Si todavía no tiene una cuenta de Xbench, debe registrarse para crearla. 
Haga clic en el vínculo Sign Up de la ventana Sign In para expandirla 
con los campos para el proceso de registro. 

 

Escriba su correo electrónico y la contraseña dos veces, y haga clic en 
Sign Up for Xbench. 

En unos pocos segundos, recibirá un correo de verificación en la bandeja 
de entrada del correo electrónico. Abra el elemento de correo electrónico 
y haga clic en el vínculo Verify your email address. 

Ahora puede iniciar sesión con las credenciales recientemente creadas. 
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En esta sección, se detallan las funciones de búsqueda de ApSIC Xbench. 
Los siguientes conceptos resultan útiles para entender el funcionamiento 
de ApSIC Xbench: 

Proyecto: En ApSIC Xbench, un proyecto es una definición de archivos 
junto con sus prioridades y relaciones. Lo primero que se debe hacer en 
ApSIC Xbench es definir un proyecto que incluya la terminología que se 
desea buscar e indicar cómo se debe buscar. 

Traducción en curso: ApSIC Xbench permite marcar un archivo o un 
conjunto de archivos como «traducción en curso» para identificar 
visualmente las cadenas en los resultados de una búsqueda. Además, las 
funciones de control de calidad (QA) solo se realizan en los archivos 
definidos como traducción en curso. 

Lista de comprobación: En ApSIC Xbench, una lista de comprobación es 
un conjunto de búsquedas que se pueden ejecutar en lote. 

PowerSearch: Se trata de un modo especial de búsqueda, gracias al cual 
se pueden definir condiciones Y/O y negaciones de la cadena de 
búsqueda para llevar a cabo búsquedas complejas. Se trata de una función 
muy útil para actividades relacionadas con el control de calidad. 

Expresión regular: Una expresión regular es una cadena de búsqueda que 
contiene caracteres especiales con significados específicos que permiten 
determinar una manera concisa y flexible de identificar patrones de 
caracteres y palabras. La sintaxis de las expresiones regulares se ajusta a 
los estándares de la industria. Es uno de los modos de búsqueda y control 
de calidad de ApSIC Xbench. 

Comodín de Microsoft Word: ApSIC Xbench también permite efectuar 
búsquedas utilizando los comodines de Microsoft Word, los cuales siguen 
una sintaxis similar a la de las expresiones regulares aunque, 
normalmente, se trata de una versión alternativa simplificada. 

  
 

Cómo trabajar con funciones de 
búsqueda 
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Cómo definir proyectos 
de búsqueda 

El primer paso para utilizar las funciones de búsqueda avanzada de 
ApSIC Xbench es definir el material de referencia del proyecto. Para ello, 
se deben agregar los archivos y directorios pertinentes al proyecto desde 
Project->Properties o presionando F2. Aparece el cuadro de diálogo 
Project Properties que se muestra a continuación. 

 

Haga clic en el botón Add para agregar archivos al proyecto. 

Seleccione el tipo de archivo que se agrega al proyecto de 
ApSIC Xbench: 
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ApSIC Xbench admite los siguientes formatos de archivo: 

 Archivo de texto delimitado por tabulaciones (*.txt, *.tsv, *.utx). Un archivo 
donde cada línea consta de una cantidad de campos delimitados por el 
carácter de tabulación. El primer y el segundo campo de una entrada 
suponen ser el texto fuente y el texto meta respectivamente. Los campos 
adicionales suponen ser descriptivos y pueden aparecer en una cantidad 
indefinida. Los archivos de texto delimitados por tabulaciones UTX 
también son compatibles con este formato. 

 Archivo XLIFF (*.xlf, *.xlif, *.xliff, *xlz, *.mxliff, *.mqxlz). Un archivo que 
cumple con la especificación XLIFF. 

 Memoria en formato TMX (*.tmx). Un archivo que cumple con la 
especificación TMX. La mayoría de las herramientas de traducción 
pueden generar memorias en formato TMX según distintos niveles de 
conformidad. 

 Glosario en formato TBX/MARTIF (*.xml, *.tbx, *.mtf). Un archivo que 
cumple con la especificación TBX o MARTIF. 

 Archivo TIPP (*.tipp). Un archivo que cumple con la especificación TIPP. 
 Memoria de Trados exportada (*.txt). Una memoria de Trados en 

formato *.txt que se exportó desde Trados. 
 Glosario de Trados MultiTerm 5 exportado (*.txt). Un glosario de 

MultiTerm exportado en un archivo *.txt donde cada entrada se 
encuentra delimitada con una línea que contiene dos asteriscos (**). 

 Glosario de Trados MultiTerm (*.xml, *.sdltb, *.mdb). Un glosario de 
MultiTerm exportado en formato XML, SDLTB o MDB. 

 Archivo de Trados TagEditor (*.ttx). Un archivo *.ttx de Trados. 
 Archivo de Word para Trados (*.doc, *.rtf). Un archivo *.doc o *.rtf 

para Trados con segmentos bilingües. 
 Archivo de Trados Studio (*.sdlxliff, *.sdlproj). Un archivo *.sdlxliff o 

*.sdlproj de Trados Studio. Cuando se especifica un archivo de 
proyecto de Trados Studio (*.sdlproj), ApSIC Xbench abre los 
archivos *.sdlxliff indicados por el archivo de proyecto para el primer 
par de idiomas que se encuentra en el archivo de proyecto. 

 Memoria de Trados Studio (*.sdltm). Una memoria de traducción de 
Trados Studio en formato *.sdltm. 

 Archivo de memoQ. Un archivo XLIFF de memoQ con extensión 
*.mqxlz o *.mqxliff, o un archivo de envío (*.mqout), un archivo de 
entrega (*.mqback) o una base de datos terminológica (*.csv) de 
memoQ. 

 Archivo de SDLX (*.itd). Un archivo *.itd de SDLX. Nota: Para esta 
opción, se necesita tener SDLX instalado en el equipo.  

 Memoria de SDLX (*.mdb). Un archivo individual *.mdb de SDLX que 
contiene una memoria de traducción. 

 Directorio de STAR Transit 2.6/XV/NXT. Un directorio que contiene 
pares de idiomas de Transit. 

 Archivo PO. Un archivo bilingüe *.po, por lo común, generado con 
gettext. 

 Diccionario de IBM TM/OpenTM2 (*.sgm). Un diccionario de IBM 
TranslationManager o de OpenTM2 en formato SGML. Este archivo 
tiene la extensión *.sgm. 
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 Carpeta de IBM TM/OpenTM2. Una carpeta de IBM TranslationManager o 
de OpenTM2 instalada en el sistema. Este formato se puede definir como 
traducción en curso para distinguir de manera clara la traducción nueva 
respecto de la anterior y también para mostrar los segmentos sin traducir 
y así poder tomar mejores decisiones en cuanto a la nueva terminología. 

 Carpeta de IBM TM/OpenTM2 exportada (*.fxp). Una carpeta de IBM 
TranslationManager o de OpenTM2 exportada en formato *.fxp. 

 Memoria de IBM TM/OpenTM2 exportada (*.exp). Una memoria de IBM 
TranslationManager o de OpenTM2 exportada en formato *.exp. 

 Memoria de Wordfast (*.txt). Una memoria de Wordfast, con la 
extensión *.txt. 

 Glosario de Wordfast (*.txt). Un glosario de Wordfast, con la extensión 
*.txt. 

 Archivo TXML de Wordfast Pro (*.txml, *.txlf). Un archivo bilingüe de 
Wordfast Pro, con la extensión *.txml o *.txlf. 

 Archivo de Déjà Vu X/Idiom (*.dvprj, *.dvsat, *.dvpng, *.wsprj). Una base 
de datos de Déjà Vu o de Idiom de los archivos de traducción de un 
proyecto, con extensiones *.dvprj, *.dvsat, *.dvpng o *.wsprj. 

 Memoria de Déjà Vu X/Idiom (*.dvmdb, *.wstm). Una memoria de 
traducción de Déjà Vu o de Idiom, con extensiones *.dvmdb o *.wstm. 

 Base de datos terminológica de Déjà Vu X/Idiom (*.dvtdb, *.wstd). Una 
base de datos terminológica de Déjà Vu o de Idiom, con extensiones 
*.dvtdb o *.wstd. 

 RTF de Logoport (*.rtf). Un archivo individual *.rtf de Logoport o un 
directorio con archivos *.rtf de Logoport. 

 Glosario de Microsoft (*.csv). Un glosario de software de Microsoft, 
puesto a disposición del público por parte de Microsoft a través de 
MSDN y que contiene todas las cadenas de una aplicación de 
software de Microsoft. 

 Glosario de Mac OS X (*.ad, *.lg). Un archivo en formato XML para 
software de Apple, el cual se puede descargar de manera gratuita en 
Internet. 

 Archivos de Qt Linguist (*.ts). Un archivo en el formato de traducción 
para el entorno Qt. 

 Glosarios de Passolo (*.glo). Un glosario de Passolo, con extensión *.glo.  
 Proyecto de Transifex. Un proyecto de Transifex en línea. 
 Trabajo de Matecat. Un trabajo en línea de Matecat, tanto desde 

www.matecat.com como autoalojado. 
 Remote Xbench Server. Una referencia a un glosario en Remote 

ApSIC Xbench Server. 

Después de seleccionar el tipo de archivo, aparece la pestaña File List, 
donde se pueden agregar varias entradas del tipo seleccionado. Según el 
tipo de archivo elegido, haga clic en el botón Add File... o Add Folder... 
para agregar entradas a la lista. 

A partir de este punto, la secuencia de pantallas puede ser diferente, 
dependiendo del tipo de archivo seleccionado. Siga las instrucciones 
correspondientes al tipo específico de archivo para obtener los pasos exactos. 



 

20 Manual de usuario de ApSIC Xbench  
 

Si se agrega... Realice estos pasos: 

Archivo de texto delimitado por 
tabulaciones, archivo XLIFF, 
memoria TMX, archivo TIPP, 
memoria de Trados exportada, 
archivo de Trados TagEditor, 
archivo de Word para Trados, 
archivo de Trados Studio, 
memoria de Trados Studio, 
archivo de memoQ, archivo de 
SDLX, memoria de SDLX, 
archivo PO, diccionario de IBM 
TM/OpenTM2, carpeta de IBM 
TM/OpenTM2 exportada, 
memoria de IBM TM/OpenTM2 
exportada, memoria de 
Wordfast, glosario de Wordfast, 
archivo TXML/TXLF de 
Wordfast Pro, glosario de 
Microsoft, glosario de Mac OS 
X, archivo de Déjà Vu X/Idiom, 
memoria de Déjà Vu/Idiom, base 
de datos terminológica de Déjà 
Vu/Idiom, archivo RTF de 
Logoport, archivo de Qt 
Linguist, glosario de Passolo 

1 Aparece la pestaña File List. Haga 
clic en Add File... o Add Folder... 
para agregar archivos o carpetas de 
archivos del tipo seleccionado. En la 
lista, las carpetas aparecen en 
negrita. 

2 Haga clic en Next en la pestaña File 
List para ir a la pestaña Properties. 

3 Asigne las propiedades pertinentes y 
haga clic en OK para terminar. 
Nota: Si se agregaron carpetas en el 
paso 1, haga clic en Next para pasar 
a un panel adicional donde se puede 
indicar si se desea incluir archivos 
del mismo tipo en carpetas 
secundarias con la casilla Recurse 
Directories. 

Directorio de STAR Transit 1 Después de que aparezca la pestaña 
File List, se abre de manera 
automática el cuadro de diálogo 
Select Directory.... Navegue hasta 
el directorio que contiene los 
archivos que se desean cargar en el 
proyecto de ApSIC Xbench. 

2 Haga clic en Next en la pestaña File 
List para ir a la pestaña Properties. 

3 Asigne las propiedades pertinentes 
al directorio y haga clic en Next 
para pasar a la pestaña Directory 
Settings. 

4 En la pestaña Directory Settings, se 
puede activar la casilla Recurse 
Directories para que 
ApSIC Xbench busque también 
archivos en los subdirectorios. 

Glosario de Trados MultiTerm 5 
exportado, Trados MultiTerm o 
en formato TBX/MARTIF 

1 Aparece la pestaña File List. Si 
hace clic en Add File... se abrirá el 
cuadro de diálogo Add Glossary 
para agregar archivos. Seleccione 
todos los archivos del tipo actual en 
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esta ventana. Si desea seleccionar 
más archivos desde otro directorio, 
cuando vuelva a la pestaña File 
List, haga clic en el botón Add File 
para volver a abrir la ventana Add 
Glossary. 

2 Haga clic en Next en la pestaña File 
List para ir a la pestaña Properties. 

3 Asigne las propiedades pertinentes 
al archivo y haga clic en Next para 
pasar a la pestaña correspondiente al 
formato de archivo. 

4 Seleccione el idioma fuente y el 
idioma meta de la lista de idiomas 
que aparece y haga clic en OK para 
terminar. 

Carpeta de IBM TM/OpenTM2 1 Después de que aparezca la pestaña 
File List, se abre de manera 
automática el cuadro de diálogo 
Select IBM TM/OpenTM2 Folder. 
Si es necesario, cambie a la unidad 
que contiene la carpeta de IBM TM 
o de OpenTM2 y, luego, seleccione 
las carpetas en la lista de carpetas 
que aparece. 

2 Haga clic en Next en la pestaña File 
List para ir a la pestaña Properties. 

3 Asigne las propiedades pertinentes y 
haga clic en OK para terminar. 

Proyecto de Transifex 1 Asigne las propiedades pertinentes 
y haga clic en Next para pasar a la 
pestaña Transifex. 

2 Escriba el identificador del proyecto 
de Transifex o pegue la URL de un 
proyecto de Transifex y haga clic en 
Connect. 

3 Seleccione un idioma de la lista de 
idiomas del proyecto y haga clic en 
OK. 

Trabajo de Matecat 1 Asigne las propiedades pertinentes 
y haga clic en Next para pasar a la 
pestaña Matecat. 

2 Pegue en Matecat URL la URL que 
aparece en el navegador cuando 
abre el trabajo de Matecat en el 
editor en línea. 
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Remote Xbench Server 1 Asigne las propiedades pertinentes 
y haga clic en Next para pasar a la 
pestaña Remote Xbench Server. 

2 Asigne un nombre para la conexión 
y especifique la URL del Xbench 
Server. 

Al volver a la ventana Project Properties, se pueden agregar otros 
archivos o directorios siguiendo los pasos descritos anteriormente. 

Al terminar, haga clic en OK en la ventana Project Properties para 
volver a la ventana principal de ApSIC Xbench. ApSIC Xbench carga los 
glosarios en el entorno de trabajo. 

En este punto, desde el menú Project, haga clic en Save as para guardar 
el proyecto recién creado en el directorio junto con otros proyectos de 
ApSIC Xbench. Se recomienda guardar los archivos de proyecto con un 
nombre significativo para uso posterior.  

Nota: La próxima vez que se inicie, ApSIC Xbench cargará de manera 
automática el último proyecto, a menos que se deshabilite esta función 
desde Tools->Settings->Miscellaneous. 
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Cómo buscar términos 
ApSIC Xbench tiene un motor de búsqueda muy avanzado. Por ejemplo, 
se puede buscar por término fuente, por término meta o por ambos al 
mismo tiempo. ApSIC Xbench también permite buscar utilizando 
expresiones regulares o comodines de Microsoft Word, y combinándolos 
mediante el modo PowerSearch. 

 

Probablemente, la mayoría de las búsquedas se lleven a cabo por término 
fuente. Sin embargo, no habrá necesidad de buscar un término mientras 
se trabaje en la interfaz de ApSIC Xbench, sino cuando se esté 
traduciendo en Word o en alguna aplicación TAO como Trados Studio, 
memoQ, Wordfast, Déjà Vu, o cuando se esté redactando en un programa 
de correo electrónico como Microsoft Outlook. 

Esa es la razón por la que se puede acceder a ApSIC Xbench desde 
cualquier aplicación en todo el sistema, mediante una combinación de 
teclas única (Ctrl+Alt+Insert). 

Los siguientes 5 pasos describen cómo interactuar con ApSIC Xbench. El 
punto de inicio de esta situación imaginaria es un documento abierto en 
Microsoft Word en un primer plano y un proyecto de ApSIC Xbench 
cargado en un segundo plano. 

1 En Microsoft Word, seleccione (de manera total o parcial) el término 
que desea buscar.  

C A P Í T U L O  5  
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2 En Microsoft Word, presione Ctrl+Insert y, luego, Ctrl+Alt+Insert para 
activar ApSIC Xbench. Esta acción inicia una búsqueda automática 
del término marcado en los archivos cargados en ApSIC Xbench. 
Esta secuencia de teclas es la más importante mientras se utiliza 
ApSIC Xbench para buscar terminología.  

3 ApSIC Xbench presenta los resultados de la búsqueda como se 
muestra en la figura anterior. 

Se pueden tener hasta tres áreas de prioridad: una en verde (prioridad 
alta), una en granate (prioridad media) y una en azul (prioridad baja). 
En la columna etiquetada como # aparece el número total de 
apariciones de la entrada resaltada que hay en ese archivo concreto. 

La viñeta verde  junto al término meta indica que la entrada es una 
coincidencia exacta (distingue mayúsculas y minúsculas) con la 
cadena de búsqueda. Si aparece una viñeta amarilla  junto al término 
meta, significa que la entrada es una coincidencia total salvo por las 
mayúsculas y minúsculas. Por ejemplo, si en el ejemplo anterior se 
buscara «Clipboard» en lugar de «clipboard», las viñetas serían 
verdes en lugar de amarillas, dado que las mayúsculas y minúsculas 
de la cadena de búsqueda coincidirían de manera exacta con las de la 
cadena que se encuentra en el archivo («Clipboard»). 

Cuando se traduce documentación, es muy útil esta indicación ya que 
se puede copiar y pegar el término meta, lo cual resulta más 
productivo y preciso. Los siguientes pasos describen cómo 
aprovechar esta ventaja. 

4 Si desea copiar el término meta de la entrada actualmente 
seleccionada en el portapapeles, presione Intro para cerrar la ventana 
de ApSIC Xbench. ApSIC Xbench se esconde y se vuelve a la otra 
aplicación (en este ejemplo, Microsoft Word). 

Nota: Si no se desea copiar nada en el portapapeles, presione Esc o 
Alt+F4 para esconder ApSIC Xbench y volver a Microsoft Word. 

5 Si se ha optado por cerrar la ventana de ApSIC Xbench con la tecla 
Intro, lo cual guarda el término meta en el portapapeles, se puede 
presionar Mayús+Insert para copiar el término meta en el documento. 

Notará que, en especial para las opciones de software, resulta más rápido 
buscar y pegar en lugar de escribir las opciones de software meta 
manualmente. Así, se logra ser más productivo y, al mismo tiempo, las 
traducciones son más coherentes. 

Sugerencia: Familiarícese con el procedimiento descrito hasta sentir que 
se vuelve intuitivo. Pruebe con palabras que sean coincidencias exactas 
para familiarizarse con la fase de pegado. 
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Expresiones regulares y 
comodines de Microsoft 
Word 

ApSIC Xbench permite realizar búsquedas avanzadas usando expresiones 
regulares o comodines de Microsoft Word. Para activar estos modos de 
búsqueda: 

1. Seleccione View->Show Search Options para mostrar el panel 
Search Options. 

2. Expanda el menú desplegable Search Mode y seleccione Regular 
Expressions o MS Word Wildcards. 

3. Aparece un icono junto a los campos Source Term y Target Term 
para indicar el modo de búsqueda seleccionado. 

Sintaxis de las expresiones regulares 
Carácter o 
expresión 

Significado Ejemplos 

. Cualquier carácter Jo.n coincide con John y Joan, pero no con 
Johan. 

* 0 o más instancias del carácter 
anterior 

Joh*n coincide con Jon, John y Johhn, pero 
no con Johan. 

Nota: En las expresiones regulares, el asterisco 
no se comporta igual que en los comodines de 
Microsoft Word. Para que signifique cualquier 
cantidad de caracteres, se tiene que utilizar la 
secuencia punto-asterisco (.*). Por ejemplo, 
Joh.*n coincide con John, Johhn y Johan 
(pero no con Jon). 

? 0 o 1 instancia del carácter anterior Joh?n coincide con Jon y John, pero no con 
Johan. 

+ 1 o más repeticiones del carácter 
anterior 

Joh+n coincide con John y Johhn, pero no con 
Jon o Johan. 

{m} Exactamente m repeticiones del 
carácter anterior 

Joh{2}n coincide con Johhn, pero no con Jon, 
John o Johhhn. 

C A P Í T U L O  6  
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{m,} m o más repeticiones del carácter 
anterior 

Joh{2,}n coincide con Johhn y Johhhn, pero 
no con Jon o John. 

{,n} De 1 a n repeticiones del carácter 
anterior 

Joh{,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

{m,n} De m a n repeticiones del carácter 
anterior 

Joh{1,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

< Inicio de palabra <Phon coincide con Phone pero no con iPhone. 

> Final de palabra hones> coincide con Phones pero no con 
Phone. 

Nota: Para que coincida con una palabra entera, 
se puede especificar <Phone> para Phone, pero 
no para Phones o iPhone; o se puede 
especificar <Phones*> para Phone y Phones 
pero no para iPhone o iPhones. 

^ Inicio de línea (tiene que estar al 
principio de la expresión) 

^Phone coincide con todas las unidades que 
comiencen con Phone. 

$ Final de línea (tiene que estar al final 
de la expresión) 

received$ coincide con todas las unidades que 
terminen con received. 

\ Carácter de escape: El carácter que 
lo sigue se analiza como un carácter 
simple. 

phone\. coincide con todas las unidades que 
tengan un punto después de phone. (en este 
caso, el punto no significa «cualquier carácter» 
porque está escapado). 

% Hace que el carácter o la expresión 
anterior no distinga mayúsculas ni 
minúsculas. Cuando el modo de 
búsqueda de ApSIC Xbench distinga 
mayúsculas y minúsculas, este 
modificador se puede utilizar para 
hacer que parte de una cadena de 
búsqueda no las distinga. 

En el modo de mayúsculas y minúsculas de 
ApSIC Xbench, a% coincide con a y A. De 
manera similar, P(hone)% coincide con Phone 
y PHONE, pero no coincide con phone porque 
en este caso la letra p no se encuentra incluida 
en la expresión afectada por el modificador. 

\xnn o \xnnnn  El carácter especificado por nn o 
nnnn, donde nn o nnnn es un número 
hexadecimal. Si solo se especifican 
dos dígitos, se supone que es el 
equivalente de Unicode \x00nn. 

Tanto \x48\x6f\x77\x64\x79\x3f como 
\x0048\x006f\x0077\x0064\x0079\x003f 
coinciden con Howdy? 

| Operador O ^(H|I) coincide con todas las oraciones que 
comiencen con una H o con una I. 

( ) Operador de paréntesis para 
especificar prioridad 

(^H)|I coincide con todas las oraciones que 
comiencen con una H o que contengan una I. 
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[set-expression] Un carácter que pertenece al 
conjunto definido por una expresión 
de conjuntos. Un conjunto se define 
mediante caracteres individuales (por 
ejemplo, [aeiou]) o por rangos de 
caracteres especificados por el 
carácter inicial y final (por ejemplo, 
[a-z]). 

File[0-9] coincide con File0, File1, File2 ... 
File9, pero no con FileX. 

File[ABC] coincide con FileA, FileB y FileC, 
pero no con FileD. 

[:special-set:] Un carácter que pertenece a un 
conjunto especial predefinido. En 
ApSIC Xbench, están predefinidos 
los siguientes conjuntos especiales: 
[:space:], [:control:], [:punctuation:], 
[:punct:], [:separator:], [:sep:], 
[:symbol:], [:alpha:], [:num:], 
[:xdigit:], [:alphanum:], [:letter:], 
[:digit:], [:letterdigit:], [:number:]. 
Un conjunto especial se debe utilizar 
dentro de expresiones de conjuntos 
(por ejemplo, [:digit:]). Los 
caracteres con los que coincide cada 
conjunto especial se encuentran 
listados en Conjuntos especiales (en 
la página 31). 

File[:digit:] coincide con File0, File1 o File2, 
pero no con FileA o FileB. 

File[:alpha:][:digit:] coincide con FileA0, 
FileB1 o FileC2, pero no con File1A o File2B. 

[^set-
expression] 

Cualquier carácter que no pertenezca 
a la expresión de conjuntos. 

File[^ABC] coincide con FileD o FileE, pero 
no con FileA, FileB y FileC. 

(expression)=n Asigna a una variable n el valor 
resuelto de la expresión en el 
segmento actualmente analizado. El 
valor resuelto se puede recuperar con 
la expresión @n. 

(File[0-9])=1 define la variable 1 como el valor 
resuelto de File[0-9]. 

@n Representa el valor resuelto de la 
variable n. 

@1 en el ejemplo anterior se resuelve en la 
cadena File1 si la cadena en la que se busca 
contiene File1, File2 si contiene File2 y así 
sucesivamente. 
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Sintaxis de los comodines de Microsoft Word 
Carácter o 
expresión 

Significado Ejemplos 

. Cualquier carácter Jo.n coincide con John y Joan, pero no con 
Johan. 

* 0 o más caracteres Joh*n coincide con John, Johan y Johhn, pero 
no con Jon. 

? 0 o 1 caracteres Jo?n coincide con Jon, John y Joan, pero no 
con Johan. 

@ 1 o más repeticiones del carácter 
anterior 

Joh@n coincide con John y Johhn, pero no 
con Jon o Johan. 

{m} Exactamente m repeticiones del 
carácter anterior 

Joh{2}n coincide con Johhn, pero no con Jon, 
John o Johhhn. 

{m,} m o más repeticiones del carácter 
anterior 

Joh{2,}n coincide con Johhn y Johhhn, pero 
no con Jon o John. 

{,n} De 1 a n repeticiones del carácter 
anterior 

Joh{,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

{m,n} De m a n repeticiones del carácter 
anterior 

Joh{1,2}n coincide con John y Johhn, pero no 
con Jon o Johhhn. 

< Inicio de palabra <Phon coincide con Phone pero no con iPhone. 

> Final de palabra hones> coincide con Phones pero no con 
Phone. 

Nota: Para que coincida con una palabra entera, 
se puede especificar <Phone> para Phone, pero 
no para Phones o iPhone; o se puede 
especificar <Phones*> para Phone y Phones 
pero no para iPhone o iPhones. 

^ Inicio de línea (tiene que estar al 
principio de la expresión) 

^Phone coincide con todas las unidades que 
comiencen con Phone. 

$ Final de línea (tiene que estar al final 
de la expresión) 

received$ coincide con todas las unidades que 
terminen con received. 

\ Carácter de escape: El carácter que 
lo sigue se analiza como un carácter 
simple. 

phone\. coincide con todas las unidades que 
tengan un punto después de phone. (en este 
caso, el punto no significa «cualquier carácter» 
porque está escapado). 
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\xnn o \xnnnn El carácter especificado por nn o 
nnnn, donde nn o nnnn es un número 
hexadecimal. Si solo se especifican 
dos dígitos, se supone que es el 
equivalente de Unicode \x00nn. 

Tanto \x48\x6f\x77\x64\x79\x3f como 
\x0048\x006f\x0077\x0064\x0079\x003f 
coinciden con Howdy? 

| Operador O ^(H|I) coincide con todas las oraciones que 
comiencen con una H o con una I. 

( ) Operador de paréntesis para 
especificar prioridad 

(^H)|I coincide con todas las oraciones que 
comiencen con una H o que contengan una I. 

[set-expression] Un carácter que pertenece al conjunto 
definido por una expresión de 
conjuntos. Un conjunto se define 
mediante caracteres individuales (por 
ejemplo, [aeiou]) o por rangos de 
caracteres especificados por el carácter 
inicial y final (por ejemplo, [a-z]). 

File[0-9] coincide con File0, File1, File2 ... 
File9, pero no con FileX. 

File[ABC] coincide con FileA, FileB y FileC, 
pero no con FileD. 

[:special-set:] Un carácter que pertenece a un 
conjunto especial predefinido. En 
ApSIC Xbench, están predefinidos 
los siguientes conjuntos especiales: 
[:space:], [:control:], [:punctuation:], 
[:punct:], [:separator:], [:sep:], 
[:symbol:], [:alpha:], [:num:], 
[:xdigit:], [:alphanum:], [:letter:], 
[:digit:], [:letterdigit:], [:number:]. 
Un conjunto especial se debe utilizar 
dentro de expresiones de conjuntos 
(por ejemplo, [:digit:]). Los 
caracteres con los que coincide cada 
conjunto especial se encuentran 
listados en Conjuntos especiales (en 
la página 31). 

File[:digit:] coincide con File0, File1 o File2, 
pero no con FileA o FileB. 

File[:alpha:][:digit:] coincide con FileA0, 
FileB1 o FileC2, pero no con File1A o File2B. 

[!set-expression] Cualquier carácter que no pertenezca 
a la expresión de conjuntos. 

File[!ABC] coincide con FileD o FileE, pero no 
con FileA, FileB y FileC. 

(expression)=n Asigna a una variable n el valor 
resuelto de la expresión en el 
segmento actualmente analizado. El 
valor resuelto se puede recuperar con 
la expresión \n. 

(File[0-9])=1 define la variable 1 como el valor 
resuelto de File[0-9]. 

\n Representa el valor resuelto de la 
variable n. 

\1 en el ejemplo anterior se resuelve en la 
cadena File1 si la cadena en la que se busca 
contiene File1, File2 si contiene File2 y así 
sucesivamente. 
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Conjuntos especiales 
La siguiente tabla muestra los caracteres con los que coinciden los 
conjuntos especiales que se pueden utilizar para las expresiones regulares 
y los caracteres comodines de Microsoft Word: 

Conjunto especial Caracteres con los que coincide el conjunto especial 

[:alpha:] Cualquiera de los caracteres considerados alfabéticos 
por el sistema operativo según la actual página de 
códigos ANSI. 

[:alphanum:] Cualquiera de los caracteres considerados 
alfanuméricos por el sistema operativo según la 
actual página de códigos ANSI. 

[:control:] Caracteres en el rango hexadecimal 0x00-0x19. 

[:digit:] Cualquier dígito de 0 a 9. 

[:letter:] Cualquiera de los caracteres considerados alfabéticos 
en cualquier idioma. Por ejemplo, coincide con letras 
tailandesas, griegas, hebreas, latinas, etc. 

[:letterdigit:] Cualquiera de los caracteres considerados 
alfanuméricos en cualquier idioma. 

[:num:], [:number:] Cualquier dígito de 0 a 9 y los siguientes números 
superíndices y fraccionarios: '¹', '²', '³', '¼', '½', '¾' 

[:punct:], [:punctuation:] Cualquiera de los siguientes caracteres: ! " # % & ' ( ) 
* , - . / : ; ? @ [ \ ] _ { } ¡ «  · » ¿ 

[:sep:], [:separator:] Espacio (Hex 0x20) y espacio fijo (Hex 0xA0) 

[:symbol:] Cualquiera de los siguientes caracteres: $ + <=> ^ ` | 
~ ¢ £ ¤ ¥ ¦ § ¨ © ¬ ® ¯ ° ± ´ ¶ ¸ × ÷ 

[:space:] Espacio (Hex 0x20), tabulaciones y retornos de carro 
en el rango Hex 0x09-0x0C, más Hex 0x85 y Hex 
0xA0. 

[:xdigit:] Cualquier dígito hexadecimal de 0 a 9 y de «a» a «f» 
(o de «A» a «F»). 
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Funciones avanzadas 
ApSIC Xbench tiene algunas funciones avanzadas que podrá apreciar 
cuando tenga requerimientos especiales. Se describen en las siguientes 
secciones. 

Función PowerSearch 
Puede utilizar la combinación de teclas Ctrl+P (PowerSearch) para buscar 
según criterios más complejos. Con la función PowerSearch, se pueden 
buscar entradas:  

 que contienen dos o más cadenas, pero no necesariamente juntas; 
 que no contienen una cadena determinada; 
 que contienen una cadena u otra cadena; 
 cualquier combinación de las condiciones anteriores. 

Ejemplos: 

Esta expresión... ... hace lo siguiente 

cadena1 cadena2 Encuentra todas las entradas que contengan 
«cadena1» y «cadena2» 

cadena1 or cadena2 Encuentra todas las entradas que contengan 
«cadena1» o «cadena2» 

cadena1 -cadena2 Encuentra todas las entradas que contengan 
«cadena1» pero que no contengan 
«cadena2» 

cadena1 -"cadena2 con espacios 
en blanco incrustados" 

Encuentra todas las entradas que contengan 
«cadena1» pero que no contengan 
«cadena2 con espacios en blanco 
incrustados» 

Se pueden utilizar paréntesis para indicar precedencia en expresiones más 
complejas que incluyan varias cadenas con relaciones booleanas Y/O. 

En el modo PowerSearch, se deben utilizar comillas dobles como 
delimitadores si la expresión contiene espacios en blanco incrustados o 
paréntesis. Si la cadena de búsqueda contiene una comilla doble 
incrustada, se debe escapar utilizando una secuencia de dos comillas 
dobles. 
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Nota: Si una de las palabras por buscar en el modo PowerSearch es la 
palabra «or», se debe poner comillas dobles delante y detrás de la palabra 
para evitar que sea analizada como el operador O. 

Se puede utilizar PowerSearch en cualquiera de los siguientes modos: 
Simple, Regular Expressions o MS Word Wildcards. 

Zoom 
ApSIC Xbench cuenta con 4 tipos de zoom: 

 Zoom to Level (zoom a nivel). Muestra las entradas que pertenecen a 
un nivel de prioridad determinado. 

 Zoom to Glossary (zoom a glosario). Muestra las entradas que 
pertenecen a un glosario determinado. Si el glosario consta de un solo 
archivo, se obtiene el mismo resultado que con Zoom to File.  

 Zoom to File (zoom a archivo). Muestra las entradas que pertenecen 
a un archivo determinado. 

 Zoom to Flag (zoom a marca). Muestra las entradas que pertenecen a 
aquellos glosarios a los que se ha asignado una marca específica en 
las propiedades.  

Como se habrá observado, ApSIC Xbench muestra una instantánea de los 
términos más pertinentes para cada nivel de prioridad en una vista 
unificada. Esto permite analizar el origen de potenciales incoherencias o, 
incluso, distintos significados, y ayuda a tomar decisiones mejor 
fundamentadas respecto a qué término elegir. 

Sin embargo, es posible que se desee ver más instancias (o todas las 
instancias) de un nivel específico para llevar a cabo un análisis más 
riguroso de un término específico. 

Para ello, haga doble clic en el cuerpo de la ventana del nivel en el que se 
desea hacer zoom para obtener una lista completa de las entradas para el 
término buscado. El fondo se vuelve verde, de forma que se reconoce que 
está en modo zoom. 

Para salir del modo zoom, haga doble clic nuevamente en el cuerpo de la 
ventana. 

Búsqueda inversa 
ApSIC Xbench también define una tecla válida en todo el sistema para 
buscar en la columna del texto meta en lugar de en la columna del texto 
fuente. La combinación de teclas predeterminada para esta función es 
Ctrl+Alt+Retroceso. 
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Esto equivale a dejar el campo Source Term en blanco y el campo 
Target Term relleno. 

Por ejemplo, resulta conveniente cuando desea utilizar un término nuevo 
en su idioma y se quiere asegurar de que dicho término no está siendo 
utilizado para otro término, lo cual podría crear potenciales conflictos en 
el futuro respecto a la terminología del proyecto. 

Cómo filtrar el alcance de la 
búsqueda 

El panel Search Options (View->Show Search Options) permite acotar 
el alcance de la búsqueda. Las opciones disponibles para filtrar la 
búsqueda son: 

 Only New Segments: Solo muestra coincidencias en los segmentos 
que no tienen un 100 % de coincidencia. 

 Only 100% Matches: Solo muestra coincidencias en los segmentos 
que tienen un 100 % de coincidencia. 

 Only Ongoing Translation: Solo muestra las coincidencias que hay 
en los archivos que se definieron como traducción en curso dentro de 
las propiedades del proyecto. 

 Exclude ICE Segments: Excluye las coincidencias contextuales 
exactas (también conocidas como coincidencias al 101 % o 
coincidencias perfectas) de los resultados de la búsqueda. 

Cómo visualizar el contexto 
Al hacer clic derecho en un resultado de la búsqueda y elegir el elemento 
de menú See Context, se mostrarán todas las unidades que en el archivo 
se encuentran físicamente antes y después de la entrada actual. 

Cómo ignorar las etiquetas 
Si las coincidencias de la búsqueda dentro de las etiquetas se deben 
excluir de los resultados de la búsqueda, se puede elegir la casilla Ignore 
Tags en el panel Search Options.  
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Cómo editar el documento 
fuente 

El elemento de menú Tools->Edit Source, también asociado a la 
combinación de teclas Ctrl+E, permite abrir el archivo fuente al cual 
pertenece la entrada actualmente seleccionada. Esto es muy útil para 
corregir rápidamente un error detectado en una traducción en curso. 

Para muchos formatos, por ejemplo, cuando el archivo fuente es un 
archivo *.itd de SDLX, un archivo *.ttx de Trados TagEditor, un archivo 
de Word para Trados, un archivo de memoQ, un archivo de Trados 
Studio o una carpeta de IBM Translation Manager, ApSIC Xbench va 
directamente al segmento que contiene el texto. 

Para Transifex, se abre una ventana en la que puede escribir la corrección 
y enviarla a Transifex. Para Matecat, se abre un navegador con el editor 
en línea en el segmento a editar. 

Para utilizar esta función con IBM Translation Manager, asegúrese de 
que IBM Translation Manager esté activo y de que no haya ningún 
documento en proceso de edición. 

Para los archivos delimitados por tabulaciones y las memorias de Trados 
exportadas, también está disponible el posicionamiento en la línea, pero 
se deben configurar los parámetros del editor de texto desde Tools-
>Settings->Text Editor. Por ejemplo, para configurar el 
posicionamiento de línea en TextPad 4, se debe seleccionar allí el 
ejecutable de TextPad y en Command-line Parameters se debe 
especificar lo siguiente: $filename($line,$column). De manera similar, 
para configurar Notepad++, se debe elegir el ejecutable y en Command-
Line Parameters se debe especificar lo siguiente: $filename -n$line. 
Otros editores de texto admitirán distintos valores para este campo. 
Consulte la documentación del editor de texto para obtener los valores 
adecuados. 

Para el formato TMX, ApSIC Xbench permite también posicionarse en 
un segmento, aunque se debe configurar el editor de TMX desde Tools-
>Settings->TMX Editor. Por ejemplo, para configurar el 
posicionamiento en un segmento en OKAPI Olifant, se debe seleccionar 
allí el ejecutable de Olifant y en Command-line Parameters se debe 
especificar lo siguiente: $Filename row=$Segment col=trg edit=yes. Otros 
editores de TMX pueden tener distintos valores para este campo. 
Consulte la documentación del editor de TMX para obtener los valores 
adecuados.  

Esto convierte a ApSIC Xbench en una herramienta muy útil y eficiente 
para efectuar cambios de terminología globales en estos formatos. Si más 
tarde se desea comprobar que todos los cambios se han realizado 
correctamente, se puede volver a cargar el proyecto de ApSIC Xbench 
con Project->Reload o Project->Refresh Content. 
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Plantillas de búsqueda 
Las plantillas de búsqueda son búsquedas predefinidas que se pueden 
seleccionar o ejecutar. Para utilizar una plantilla de búsqueda, haga clic 
en Search Templates... del panel Search Options y, luego, seleccione la 
búsqueda de la lista. En Template Source, se puede elegir mostrar las 
entradas Sample Search Templates o Project Checklist. Haga clic en 
Search para ejecutar de manera directa la búsqueda actualmente 
seleccionada o haga clic en Choose para llevar la definición de plantilla 
de búsqueda a los campos Source Term y Target Term. 

Cómo cambiar la 
disposición de los campos 
de búsqueda 

Puede alternar la disposición vertical con la horizontal de los campos 
Source Term y Target Term en la pestaña Search. En la disposición 
horizontal, el campo Target Term aparece junto al campo Source Term 
y el panel ocupa menos espacio en pantalla. Por lo tanto, hay más espacio 
para los resultados de la búsqueda. En la disposición vertical, el campo 
Target Term aparece debajo del campo Source Term y los campos son 
más anchos.  

Para alternar la disposición vertical con la horizontal, suba o baje el borde 
inferior del panel Source/Target para contraerlo o expandirlo. 
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Cómo exportar elementos 
ApSIC Xbench permite exportar los elementos de un proyecto en los 
siguientes formatos: 

 Archivos TMX 
 Archivos de texto delimitado por tabulaciones 
 Archivos de Excel 
 Archivos de Word 

Para exportar el contenido de un proyecto, seleccione Tools->Export 
Items. Aparece el siguiente cuadro de diálogo: 

 

En este cuadro de diálogo, se pueden exportar todos los elementos de un 
proyecto, todos los elementos de la búsqueda actual, únicamente los 
elementos que muestra la búsqueda actual (por ejemplo, si se está en 
modo de descripción general, se ven únicamente algunos elementos de 
cada nivel de prioridad) o todos los elementos de un glosario que 
constituye el proyecto. 

En caso de desearlo, se pueden quitar las repeticiones (elementos que 
tengan exactamente los mismos valores fuente y meta) de los datos 
exportados para reducir el tamaño del archivo resultante. También se 
pueden excluir de la búsqueda los segmentos ICE (coincidencias 
contextuales exactas). 

Además, se pueden exportar únicamente los elementos sin traducir (por 
ejemplo, para facilitar el suministro en un sistema de traducción 
automática) o únicamente los elementos traducidos. Si se opta por 
exportar únicamente los elementos traducidos, se puede también 
especificar si se desea exportar únicamente los elementos pretraducidos 
(es decir, los elementos recuperados de una memoria de traducción) o los 
elementos traducidos recientemente. 
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Al exportar en un archivo de texto delimitado por tabulaciones o un 
archivo de Excel, se puede agregar una fila de encabezado. El formato de 
los archivos Word exportados es el mismo que se genera desde Tools-
>Export Ongoing Translation to MS Word. 

Al exportar un archivo TMX, se pueden especificar las variedades locales 
fuente y meta. Se puede especificar cualquier valor en estos campos. En 
caso de no recordar el código de variedad local, se puede presionar el 
botón con puntos suspensivos (...) para abrir una ventana de ayuda en la 
cual seleccionar el idioma y el país.  

 

Si por lo general se trabaja con un conjunto limitado de idiomas, se puede 
hacer clic en el botón de flecha del cuadro combinado para abrir una lista 
de idiomas más acotada según las selecciones hechas recientemente. 
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Cómo trabajar con 
traducciones en curso 

ApSIC Xbench permite definir cualquier archivo como traducción en 
curso en la ventana Project Properties. 

Los siguientes tipos de archivo se definen como traducción en curso de 
manera predeterminada al ser agregados a un proyecto de 
ApSIC Xbench: 

 XLIFF 
 Trados TagEditor 
 Word para Trados 
 Trados Studio 
 memoQ 
 SDLX. Nota: Para esta opción, se necesita tener SDLX instalado en el 

equipo.  
 STAR Transit 2.6/XV/NXT 
 PO 
 Carpetas de IBM TM 
 Carpetas de OpenTM2 
 TXML/TXLF de Wordfast 
 Déjà Vu/Idiom 
 RTF de Logoport 
 Qt Linguist 
 Proyecto de Transifex 
 Trabajo de Matecat 

Cuando se define un archivo o un directorio como traducción en curso, se 
habilitan las dos funciones siguientes: 

 Los segmentos que se identifican como nuevos (que no son 
coincidencias 100 %) están marcados con un pequeño punto de color 
rojo ( ). Los segmentos que son coincidencias 100 % en la traducción 
en curso están marcados con un punto hueco de color rojo ( ). Estos 
símbolos permiten distinguir si se introdujo el término al traducir o si 
provenía de la memoria existente. Esto ayuda a tomar decisiones en 
cuanto a la terminología, por ejemplo, si se desea actualizar la 
traducción respecto a un término y se quiere estar seguro de que el 
término no fue ya utilizado en la memoria oficial con la que se 
pretradujo el proyecto. 
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 Los segmentos sin traducir aparecen después de los segmentos 
traducidos. Esto es útil en especial para decidir qué terminología 
utilizar para un término nuevo viendo de qué modo aparece en todas 
los casos futuros de la propia traducción. De este modo, se puede 
asegurar de que el término elegido se ajusta a todos los casos de la 
traducción actual. 

Nota: Los glosarios que se definen como traducción en curso (por lo 
general, solo uno por proyecto, pero puede haber más) aparecen en 
negrita en la ventana Project Properties. 

Adicionalmente, los archivos definidos como traducción en curso se 
pueden analizar mediante las funciones avanzadas de QA de 
ApSIC Xbench o exportar mediante Tools->Export Ongoing 
Translation to MS Word para usar el corrector ortográfico y gramatical 
de Microsoft Word (para idiomas como tailandés, japonés o chino que no 
son compatibles con los diccionarios ortográficos de Xbench). 
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Términos clave 
ApSIC Xbench permite definir uno o más archivos como Términos clave. 
Para ello, en la lista de glosarios de Project Properties, active la casilla 
Key Terms. Como se muestra a continuación, aparece una estrella verde 
junto a la entrada del glosario, la cual indica que el glosario está marcado 
con la categoría Términos clave. 

 

Al definir un archivo como término clave, las entradas aparecen con una 
estrella en la parte superior de la lista de resultados. El color de la estrella 
indica si el término clave es una coincidencia exacta (estrella verde ), 
una coincidencia exacta salvo por las mayúsculas y minúsculas (estrella 
amarilla ), o si el texto buscado forma parte de la entrada del término 
clave (estrella transparente ). 

En el siguiente ejemplo, se muestran las entradas «clipboard» y 
«Clipboard Viewer», ambas marcadas como Términos clave: 
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En el ejemplo anterior, la estrella pintada de verde junto a la entrada 
«clipboard» indica que la entrada es una coincidencia total. La estrella 
transparente en la entrada «Clipboard viewer» indica que el término 
buscado forma parte de un término clave. 

La función de control de calidad (QA) también hace uso de los términos 
clave definidos en el proyecto y comprueba si se han utilizado en la 
traducción en curso. 
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ApSIC Xbench ofrece funciones de control de calidad (QA) que permiten 
realizar comprobaciones avanzadas en los archivos definidos como 
traducción en curso. Las funciones de QA tratan de encontrar los 
siguientes problemas potenciales: 

 segmentos sin traducir; 
 segmentos que tienen el mismo texto fuente pero distinto texto meta; 
 segmentos que tienen el mismo texto meta pero distinto texto fuente; 
 segmentos donde el texto meta es idéntico al texto fuente; 
 segmentos con discrepancias de etiquetas; 
 segmentos con discrepancias numéricas; 
 segmentos con discrepancias de URL; 
 segmentos con discrepancias alfanuméricas; 
 segmentos con símbolos no emparejados (es decir, paréntesis, 

corchetes o llaves no emparejados); 
 segmentos con comillas no emparejadas; 
 segmentos con dobles espacios; 
 segmentos donde las palabras que están completamente en 

MAYÚSCULAS no coinciden entre el texto fuente y el texto meta; 
 segmentos donde las palabras que están en CamelCase no coinciden 

entre el texto fuente y el texto meta;  
 segmentos que no respetan los términos clave del proyecto; 
 segmentos que satisfacen los criterios de búsqueda de elementos en 

listas de comprobación personales o de proyecto. Para obtener más 
información acerca de esta función, consulte Cómo gestionar listas de 
comprobación. 

 segmentos con errores ortográficos, si tiene diccionarios instalados en 
Tools->Spell-Checking Dictionaries.  

  

Las funciones de control de calidad se llevan a cabo con la pestaña QA en la 
ventana principal. La pestaña QA sirve para las siguientes funciones: 

Cómo trabajar con funciones de control 
de calidad (QA) 
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 Realizar todas las comprobaciones seleccionadas en Check Group y 
en List of Checks haciendo clic en Check Ongoing Translation. 
Todas las casillas se encuentran seleccionadas de manera 
predeterminada, a excepción de Target same as Source. 

 Realizar únicamente las búsquedas definidas por las listas de 
comprobación de proyecto haciendo clic en Run Project Checklists. 

 Realizar únicamente las búsquedas definidas por las listas de 
comprobación personales actuales haciendo clic en Run Personal 
Checklists. Para cambiar las listas de comprobación personales 
actuales, seleccione View->Checklist Manager. 

 Exportar los resultados del control de calidad que se muestran 
haciendo clic derecho y seleccionando Export QA Results en los 
siguientes formatos: HTML, texto delimitado por tabulaciones, Excel 
o XML. 

Nota: Recuerde que la licencia de ApSIC Xbench no permite eliminar los 
créditos que se encuentran a la derecha al principio del informe de control 
de calidad exportado. Hemos intentado que estos créditos no resulten 
molestos; la finalidad de estos es evitar promociones tipo «Cuéntaselo a 
un amigo» u otras maneras menos discretas de promover el uso del 
producto entre pares.  

Los resultados se muestran en el cuerpo de la ventana de la pestaña QA. 
Con algunos formatos de archivo, se puede abrir el archivo directamente 
desde ApSIC Xbench en el segmento que se muestra para corregirlo 
eligiendo Tools->Edit Source o presionando Ctrl+E. 

Se puede limitar el alcance de las cadenas contempladas por el proceso de 
QA activando las casillas Only New Segments, Only 100% Matches o 
Exclude ICE Segments.  

También se puede hacer que el modo de comprobación de coherencia 
distinga entre mayúsculas y minúsculas si activa la casilla Case-sensitive 
Inconsistencies. 

Se puede ignorar el contenido de las etiquetas dentro de los segmentos al 
realizar el control de calidad si se selecciona Ignore Tags. Esto permite 
encontrar incoherencias que tienen el mismo texto fuente o meta a 
excepción de las etiquetas de elementos en línea. 

Esta ventana permite marcar un error haciendo clic derecho sobre el 
mismo y seleccionando Mark/Unmark Issue. De manera opcional, se 
pueden mostrar u ocultar los problemas marcados con los botones de 
radio Show Marked o Hide Marked en Filter Issues, con el fin de 
limitar la cantidad de problemas que se visualizan. Por ejemplo, para 
ignorar y ocultar rápidamente las falsas alarmas de la lista de resultados, 
conviene elegir Hide Marked y, luego, marcar los elementos a medida 
que se procesa la lista.  

Nota: El comando Export QA Results exporta únicamente los problemas 
que se visualizan (y no exporta los problemas que se ocultaron). 
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Cómo gestionar listas de 
comprobación 

Las listas de comprobación son una función muy útil del control de 
calidad de ApSIC Xbench. Al agregarse al motor de búsqueda de 
ApSIC Xbench, las listas de comprobación son una recopilación de 
búsquedas que se pueden ejecutar en lote para identificar segmentos con 
problemas. Típicamente, en las listas de comprobación se almacenan 
errores habituales, como el uso de expresiones o términos prohibidos. Es 
muy recomendable recopilar los comentarios de los clientes en listas de 
comprobación para asegurarse de no olvidarlos en traducciones sucesivas. 

Desde la pestaña QA de la ventana principal, se pueden ejecutar estas 
listas de comprobación en todos los archivos definidos como traducción 
en curso del proyecto de ApSIC Xbench. 

Dado que las listas de comprobación se agregan al motor de búsqueda de 
ApSIC Xbench, todo lo que se pueda buscar en ApSIC Xbench se puede 
agregar a una lista de comprobación. De hecho, una manera práctica de 
agregar una búsqueda a la lista de comprobación es realizarla primero en 
la pestaña Project y, luego, hacer clic en Add Last Search to Checklist 
en el panel Search Options de la ventana principal. 

Existen dos tipos de listas de comprobación: la lista de comprobación de 
proyecto y las listas de comprobación personales. 

La lista de comprobación de proyecto se guarda con el archivo del 
proyecto de ApSIC Xbench (extensión *.xbp) y, por lo general, contiene 
comprobaciones que son específicas del proyecto, por ejemplo, detectar si 
alguna palabra clave que no se traduce se ha traducido por error.  

Las listas de comprobación personales no se guardan en el archivo del 
proyecto de ApSIC Xbench, sino que se guardan en un archivo de lista de 
comprobación de ApSIC Xbench (extensión *.xbckl). ApSIC Xbench 
recuerda el último conjunto de listas de comprobación personales que se 
utilizaron en distintos proyectos. Se puede tener una cantidad indefinida 
de listas de comprobación personales cargadas. Por lo general, las listas 
de comprobación personales contienen comprobaciones que no son 
exclusivas de un proyecto, como errores comunes que no se detectan con 
el corrector ortográfico o reglas lingüísticas genéricas que conviene 
comprobar en varios proyectos. Son «personales» porque los términos 
recopilados en estas listas suelen ser errores que un traductor determinado 
puede llegar a cometer. 

Las listas de comprobación se gestionan en la pestaña Checklist 
Manager. Se puede abrir la pestaña Checklist Manager mediante los 
siguientes métodos: 
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 Seleccione View->Checklist Manager. 
 Haga clic en el icono Checklist Manager de la barra de 

herramientas. 

Checklist Manager permite trabajar con las listas de comprobación 
personales y de proyecto. 

 

En Checklist Manager, se pueden crear nuevas listas de comprobación 
personales seleccionando Checklist->New si el cursor está posicionado 
en el grupo Personal Checklists del árbol de navegación. También se 
puede agregar una lista de comprobación existente mediante Checklist-
>Add. Todas las listas de comprobación personales debajo de la lista 
Personal Checklists se ejecutan al hacer clic en Run Personal 
Checklists o Check Ongoing Translation en la pestaña QA. 

La lista de comprobación <Project> se almacena en el archivo del 
proyecto de ApSIC Xbench (con extensión *.xbp) y no se puede quitar 
del grupo Project Checklists del árbol de navegación. Se pueden agregar 
más listas de comprobación al grupo Project Checklists, que se ejecutan 
al hacer clic en Run Project Checklists o Check Ongoing Translation 
en la pestaña QA. Los elementos de estas listas de comprobación de 
proyecto adicionales no se guardan en el archivo del proyecto de 
ApSIC Xbench en sí, pero se vinculan al proyecto, de modo que la 
siguiente vez que se abre el archivo del proyecto de ApSIC Xbench, 
también aparece allí cualquier lista de comprobación vinculada. 

Las entradas de la lista de comprobación seleccionada en el árbol de 
navegación aparecen en el cuerpo de la ventana. Se puede ordenar por 
cualquiera de las columnas. Si se desea deshabilitar una entrada 
individual, se puede hacer clic derecho en ella y seleccionar Disable. 

Tenga en cuenta que el estado deshabilitado se guarda en el disco, de 
modo que, la próxima vez que se abra la misma lista de comprobación, la 
entrada permanecerá deshabilitada. 

Se puede probar el elemento seleccionado de la lista de comprobación 
con el proyecto cargado haciendo clic derecho en un elemento de la lista 
de comprobación y seleccionando Test. Esta acción ejecuta una búsqueda 
con los parámetros del elemento de la lista de comprobación en la pestaña 
Search, de modo que se puede ver si los resultados que devuelve la 
búsqueda corresponden al comportamiento esperado. 
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Al hacer clic en un encabezado de columna, la lista se ordena de manera 
alfabética por esa columna. Si se hace clic en el encabezado de columna 
por segunda vez, la lista se ordena de abajo hacia arriba. Si se escribe una 
secuencia de caracteres, se busca la secuencia de caracteres escrita en la 
columna actual. 

Se pueden agregar o editar entradas individuales de una lista de 
comprobación. Los campos disponibles son los mismos que se pueden 
especificar en el panel Search Options de la pestaña Search. 

 

Además, también se puede especificar una categoría para una entrada de 
la lista de comprobación en el cuadro combinado Category. Se puede 
especificar el nombre de cualquier categoría. Si se desea utilizar el 
nombre de una categoría previamente definida, puede desplegar el cuadro 
combinado haciendo clic en el botón de flecha y elegirlo de la lista. Si se 
han creado nombres de categorías, se pueden ejecutar de manera selectiva 
subconjuntos de categorías al ejecutar una lista de comprobación personal 
o de proyecto desde la pestaña QA utilizando los botones Run Project 
Checklists o Run Personal Checklists. 

También se pueden definir relaciones de herencia entre las listas de 
comprobación. Cuando una lista de comprobación hereda de otra, se 
heredan todas las entradas. Se puede heredar de varias listas de 
comprobación. 

Para heredar una lista de comprobación, realice lo siguiente: 

1. Haga clic en el botón Inheritance y, luego, haga clic derecho en la 
lista de elementos heredados que aparece y seleccione Add. 

2. Escriba un nombre para la lista de comprobación heredada y seleccione 
el nombre del archivo que la contiene. El nombre aquí especificado no 
tiene que coincidir necesariamente con el nombre de visualización de la 
lista de comprobación. 
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3. Siga los pasos 1 y 2 para agregar todas las listas de comprobación 
necesarias. El diálogo muestra los elementos heredados mediante el icono 

. Se pueden cancelar estos elementos heredados pero no editarlos ni 
eliminarlos. 

 

Una vez establecida una relación de herencia, se hereda cualquier cambio 
o adición que se lleve a cabo en la lista de comprobación primaria. 

La lista de comprobación de proyecto se guarda de manera automática al 
guardar el proyecto. Al agregar entradas a la lista de comprobación de 
proyecto y cerrar ApSIC Xbench, se le consulta si desea guardar el 
proyecto. 

Los cambios que se realizan en todas las listas de comprobación se 
guardan de forma automática, a excepción de las listas de comprobación 
<Project>, que se guardan junto con el archivo de proyecto de Xbench 
con extensión *.xbp.  

Si se desea introducir cambios en una lista de comprobación pero sin 
guardarlos, se puede crear una copia duplicada de la lista de 
comprobación haciendo clic derecho en ella y seleccionando Save as. 
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Cómo realizar el control 
de calidad desde el 
explorador de Windows 

ApSIC Xbench incluye una extensión de shell que le permite iniciar una 
sesión de control de calidad desde el explorador de Windows. Esto puede 
ser muy práctico para realizar el control de calidad de uno o más archivos 
o de un directorio. 

Para realizar el control de calidad desde el explorador de Windows: 

1 En el explorador de Windows, seleccione el archivo o directorio que 
desea verificar. 

2 Haga clic derecho y seleccione Run QA with Xbench. 

Estas acciones ejecutarán ApSIC Xbench con un proyecto recién creado 
que incluye como traducción en curso todos los archivos seleccionados 
en el explorador de Windows. 

El proyecto ya está listo para realizar el control de calidad. Si se desea 
personalizar el proyecto de ApSIC Xbench recién creado, por ejemplo, 
para agregar un archivo de términos clave, vaya a Project->Properties. 

El proyecto creado con el explorador de Windows está en el directorio 
TEMP de Windows. Si desea guardar el proyecto de ApSIC Xbench para 
reutilizarlo posteriormente, seleccione Project->Save as y especifique un 
nuevo nombre en una nueva ubicación de su equipo. 
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Cómo trabajar con el 
corrector ortográfico 
instantáneo de 
ApSIC Xbench 

ApSIC Xbench presenta un método innovador para corregir la ortografía 
de todos los archivos en curso del proyecto de manera instantánea. En 
lugar de abrir y cerrar muchos archivos, y recorrerlos lentamente con el 
corrector ortográfico, teniendo que ignorar falsas alarmas, ApSIC Xbench 
procesa todos los archivos en bloque y, luego, presenta los resultados 
correspondientes de modo que se puedan marcar los errores reales más 
rápidamente. 

ApSIC Xbench proporciona 48 diccionarios ortográficos basados en el 
motor Hunspell como principal y los diccionarios de Microsoft Word 
como secundarios si el diccionario de Microsoft Word para ese idioma 
está instalado en el equipo. Únicamente se marcan como errores las 
palabras que no existen en ambos diccionarios. Se puede desactivar la 
comprobación con Microsoft Word, si Settings->Use Microsoft Word 
dictionary está desactivada en la ventana ApSIC Xbench Spell 
Checker. 

Los diccionarios ortográficos en sí no están incluidos en el instalador de 
ApSIC Xbench. En lugar de ello, se deben descargar e instalar desde 
Tools->Spell-Checking Dictionaries. 

 

Al agregar un diccionario ortográfico, el idioma que se agrega aparece en 
el grupo Spell-checking. 
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Para incluir la corrección ortográfica en las comprobaciones a realizar, 
seleccione Spell-checking y, luego, elija el idioma en List of Checks. 
Luego, haga clic en Check Ongoing Translation. 

 

La ventana que aparece muestra todos los errores ortográficos agrupados 
por término erróneo. Revise la lista y haga doble clic en el error que 
corresponda, para mover el término realmente erróneo a la lista Real 
Misspellings. 

Una vez que haya recorrido la lista completa, haga clic en OK para 
agregar los segmentos con errores ortográficos al informe de control de 
calidad principal. 

En la ventana Spell-Checking, hay algunos ajustes que permiten reducir 
la cantidad de falsas alarmas de la lista. Para mostrarlos, haga clic en 
Exclusions. 

 

Las opciones disponibles en este panel son: 

 Words with numbers. Cuando está activada, no se consideran 
incorrectas las palabras como Pkd05 o G5HJKH7. 



 

 Capítulo 14 Cómo trabajar con el corrector ortográfico instantáneo de ApSIC Xbench 55 
 
 

 Words in mixed case with a match in source text. Cuando está 
activada, no se consideran incorrectas las palabras como PlantWorks 
si el término también aparece en el texto fuente. 

 Segments where target text matches source text. Cuando está 
activada, no se ejecuta ningún tipo de corrección ortográfica en 
aquellos segmentos en los que el texto meta coincida exactamente 
con el texto fuente. Si está en uso la comprobación de control de 
calidad Basic->Target same as Source, esta exclusión permite omitir 
las palabras que aparezcan en los segmentos que quedaron en el 
idioma original de manera deliberada.  

 Words in UPPERCASE. Cuando esta opción está activada, no se 
analizarán con el corrector las palabras que están en mayúsculas.  

 Words in UPPERCASE with a match in source text. Cuando esta 
opción está activada, no se realiza ninguna comprobación ortográfica 
en las palabras que están en MAYÚSCULAS si exactamente las 
mismas palabras también aparecen en mayúsculas en el texto fuente. 
Este ajuste puede resultar útil si la traducción contiene muchas siglas 
que no cambian de un idioma a otro.  

 Abbreviations. Cuando esta opción está activada, se omiten las 
abreviaturas. 

Cómo usar anexos 
Si la traducción contiene términos específicos del cliente, como nombres 
de productos, marcas comerciales o palabras clave comunes, es probable 
que los diccionarios no los incluyan. El corrector ortográfico de ApSIC 
Xbench permite crear uno o más anexos para cada diccionario 
determinado y habilitarlos según las necesidades del proyecto. 

Para crear un nuevo anexo en un diccionario, realice los siguientes pasos: 

1 Seleccione Addendums->Manage Addendums. 

 
2 Haga clic en Add. 

3 Escriba un nombre para el anexo y haga clic en OK. 

Una vez creado el anexo, si desea agregar uno o más términos, 
selecciónelos en la lista de problemas, haga clic derecho y seleccione 
Add to addendum: <addendum_name>. 
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Se pueden agregar tantos anexos a un diccionario como se desee. Los 
anexos se almacenan en la ruta que se especifica en Settings->Set 
Addendum Folder. 

Funciones adicionales del 
corrector ortográfico 

El corrector ortográfico de ApSIC Xbench presenta algunas funciones 
adicionales que pueden resultar de interés: 

 Se puede cambiar el tamaño de la fuente haciendo clic derecho en la 
lista Unknown Words, seleccionando Settings y, luego, Enlarge 
Font o Reduce Font. 

 Se pueden copiar las palabras desconocidas al portapapeles haciendo 
clic derecho en la lista Unknown Words, seleccionando Export y, 
luego, Copy to Clipboard. 

 Se puede abrir un archivo de Microsoft Word o Microsoft Excel con 
las palabras desconocidas haciendo clic derecho en la lista Unknown 
Words, seleccionando Export y, luego, Open in MS Word u Open 
in MS Excel. Resulta útil abrirlo en Microsoft Word si, por ejemplo, 
se desea corregir la ortografía de las palabras desconocidas restantes 
con Microsoft Word. 

 De forma predeterminada, se marcan los errores ortográficos reales 
haciendo doble clic sobre ellos y moviéndolos al cuadro de lista Real 
Misspellings. Esto se hace si se supone que la mayoría de las 
palabras desconocidas son falsas alarmas, lo cual sucede, a menudo, 
en una regresión o revisión final. Sin embargo, si el caso es el 
contrario, se puede cambiar el modo de trabajo para que en lugar de 
marcar los errores ortográficos reales, se marquen las falsas alarmas. 
Para cambiar el modo de trabajo, seleccione Settings->Change 
Working Mode.  



 

 Capítulo 14 Cómo trabajar con el corrector ortográfico instantáneo de ApSIC Xbench 57 
 
 

Corrección ortográfica y 
gramatical en Microsoft 
Word 

Puede utilizar Tools->Export Ongoing Translation to MS Word para 
crear un archivo de Microsoft Word con el texto fuente y el texto meta en 
paralelo. Por defecto, el texto fuente se marca como «no proof» 
(no comprobarlo), para que pueda utilizar F7 para revisar la columna del 
texto meta con el corrector ortográfico y gramatical de Microsoft Word, 
si está instalado para dicho idioma. Por ejemplo, puede utilizar este 
documento de Word para comprobar idiomas que no están en la lista de 
los diccionarios ortográficos de Xbench, como tailandés, finés, japonés o 
chino. 

Para arreglar un error, selecciónelo en Word, presione Ctrl+Alt+Retroceso 
para buscar el segmento en Xbench y, a continuación, presione Ctrl+E 
para abrir el segmento con el error en el editor nativo, como Trados 
Studio o memoQ. 
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Cómo trabajar con 
ApSIC Xbench Plugin for 
SDL Trados Studio 2014 

ApSIC Xbench Plugin for SDL Trados Studio 2014 permite: 

 Desde SDL Trados Studio 2014, crear de manera automática un 
proyecto de Xbench que reúne la información del proyecto actual de 
SDL Trados Studio 2014 y ejecutar ApSIC Xbench para realizar el 
control de calidad en los archivos del proyecto. 

 Desde ApSIC Xbench, utilizar el comando Edit Source de la pestaña 
Search o de la pestaña QA para abrir un archivo sdlxliff de SDL 
Trados Studio en el segmento actualmente seleccionado en Xbench y 
en el contexto del proyecto de SDL Trados Studio, al que están 
conectadas la memoria de traducción y la base de datos 
terminológica. 
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Cómo instalar o 
desinstalar el plugin 

Antes de instalar ApSIC Xbench Plugin for SDL Trados Studio 2014, 
asegúrese de que el siguiente software está instalado en su equipo: 

 SDL Trados Studio 2014 SP1. El cuadro Ayuda->Acerca de SDL 
Trados Studio debería mostrar la versión 11.1.3931 o posterior. 

 ApSIC Xbench 3.0 build 1186 o posterior. 

Si no tiene estas versiones, descárguelas e instálelas antes de instalar el 
plugin. 

Puede descargar ApSIC Xbench 3.0 y ApSIC Xbench Plugin for SDL 
Trados Studio 2014 de la página Download en http://www.xbench.net. 
Puede usar el archivo de instalación del plugin en la versión de 32 bits y 
en la versión de 64 bits de ApSIC Xbench 3.0. 

Cómo instalar el plugin 
Para instalar el plugin correctamente, necesita derechos administrativos. 
El plugin se instalará para todos los usuarios de SDL Trados Studio en el 
equipo. Tras la instalación del plugin, es necesario que ejecute SDL 
Trados Studio 2014 al menos una vez como administrador para 
desempaquetarlo. Esto es especialmente importante si se instala el plugin 
en un Terminal Server, en el que pueden trabajar usuarios sin derechos 
administrativos. 

Para instalar el plugin, haga clic en Setup.Xbench.Plugin.Studio.3.0.n.exe 
que está en el archivo que se descarga de http://www.xbench.net, y siga 
las instrucciones del asistente de instalación. 

Cómo desinstalar el plugin 
Para desinstalar ApSIC Xbench Plugin for SDL Trados Studio 2014, vaya 
al Panel de control de Windows y desinstálelo. 

Tenga en cuenta que necesita derechos administrativos para desinstalar el 
plugin. 
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Cómo utilizar el plugin 
Si ejecuta SDL Trados Studio con el plugin de ApSIC Xbench instalado, 
es probable que vea un nuevo elemento en la cinta para la vista 
Proyectos. 

 

El plugin de ApSIC Xbench instala un icono en estas tres cintas: 

 la cinta Inicio de la vista Proyectos 
 la cinta Inicio de la vista Archivos 
 la cinta Revisión de la vista Editor 

Cualquiera de estos iconos realiza la misma acción: Run QA in Current 
Project. 

La acción Run QA in Current Project hace lo siguiente: 

1 Crea un proyecto de ApSIC Xbench, con extensión .xbp, con los 
siguientes elementos: 

 Todos los archivos sdlxliff del proyecto actual se cargan como 
traducción en curso y con prioridad media (color granate). Si el 
proyecto tiene más de un idioma meta, aparece el diálogo Choose 
Language. 

 
 La primera memoria de traducción basada en archivos con 

extensión .sdltm que se encuentre para el idioma en la 
configuración del proyecto de SDL Trados Studio. Primero, el 
plugin de ApSIC Xbench analiza la configuración específica del 
idioma. Si no encuentra ninguna memoria de traducción, 
comprueba la configuración Todas las combinaciones de 
idiomas. Esta memoria de traducción se carga con prioridad baja 
(color azul) en el proyecto de Xbench. Para desactivar la carga de 
la memoria de traducción en ApSIC Xbench, seleccione Tools-
>Settings->Studio Plugin y desactive la casilla Add first local 
translation memory. Nota: Si selecciona All Languages en el 
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diálogo Choose Language, este archivo no se cargará en el 
proyecto de Xbench. 

 La primera base de datos terminológica basada en archivos con 
extensión .sdltb o .mdb que se encuentre para el idioma en la 
configuración del proyecto de SDL Trados Studio. Este glosario 
MultiTerm se carga con prioridad alta (color verde) en el proyecto 
de Xbench. Para desactivar la carga de la base de datos 
terminológica en ApSIC Xbench, seleccione Tools->Settings-
>Studio Plugin y desactive la casilla Add first local termbase. 
Nota: Si selecciona All Languages en el diálogo Choose 
Language, este archivo no se cargará en el proyecto de Xbench. 

2 Ejecuta ApSIC Xbench para cargar el proyecto y abre la pestaña QA. 

En Xbench, puede seleccionar los ajustes de control de calidad que desee 
y haga clic en Check Ongoing Translation para llevar a cabo el control 
de calidad. Recuerde que solo se tienen en cuenta los archivos de 
traducción en curso (en este caso, los archivos sdlxliff) para el control de 
calidad. Cualquier otro archivo se considera referencia para búsquedas 
ad hoc. 

Durante el control de calidad, puede buscar en los archivos sdlxliff y en 
los glosarios o en la memoria de traducción. Puede hacerlo en la pestaña 
Search de ApSIC Xbench. En el siguiente ejemplo, se muestra cómo se 
organiza la información en el proyecto generado de Xbench. 

 

Cuando encuentre un elemento en las pestañas Search o QA que desee 
cambiar, selecciónelo, haga clic derecho y elija Edit Source. También 
puede presionar la combinación de teclas Ctrl+E para ejecutar el 
comando Edit Source. Al hacerlo, SDL Trados Studio se mostrará en 
primer plano y la vista Editor abrirá el archivo en el segmento elegido en 
ApSIC Xbench. 
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Tras hacer cambios en SDL Trados Studio, presione la combinación de 
teclas Alt+Tab para volver a Xbench.  

Después de aplicar los cambios del control de calidad en SDL Trados 
Studio, presione de nuevo el icono en la cinta para realizar un control de 
calidad final rápido. Al hacer clic en el icono de la cinta, el plugin de 
Xbench guardará los archivos sin guardar y creará un nuevo proyecto de 
Xbench con los archivos actualizados. 

Para realizar un control de calidad de algunos archivos del proyecto de 
SDL Trados Studio, vaya a la vista Archivos de SDL Trados Studio, 
seleccione los archivos, haga clic derecho para mostrar el menú 
desplegable y seleccione Run QA in Selected Files with Xbench. 
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Cómo realizar el control 
de calidad en archivos de 
memoQ 

 

Instrucciones para 
memoQ 6 a memoQ 2014 
hasta el build 51 

ApSIC Xbench puede cargar archivos de memoQ .mqxliff y .mqxlz. Para 
agregar un documento de memoQ a un proyecto de Xbench, haga lo 
siguiente:  

1 En memoQ, seleccione el documento, elija Exportar archivos 
bilingües y luego memoQ XLIFF como formato de salida, y haga 
clic en Exportar.  

2 En ApSIC Xbench, seleccione Project->Properties, haga clic en 
Add y luego seleccione memoQ File.  

Sin embargo, el comando Edit Source que le permite ir al mismo 
segmento en memoQ tiene una importante limitación: solo funciona si el 
archivo .mqxliff actual está abierto en memoQ. 

Por lo tanto, para conseguir una mayor integración con memoQ, es 
necesario incluir todo el contenido que desea verificar en un solo archivo 
.mqxlz. Para ello, cree una vista en memoQ y expórtela. El procedimiento 
recomendado para realizar el control de calidad de archivos de memoQ es 
el siguiente: 

1 En memoQ, seleccione en la vista Traducciones todos los 
documentos del proyecto actual que desea verificar, haga clic derecho 
y seleccione Crear vista. Escriba, por ejemplo, ToXbench en 
Nombre de la vista, seleccione Solamente pegar los documentos y 
haga clic en Aceptar. 

2 En memoQ, en la pestaña Vistas, seleccione ToXbench, haga clic 
derecho y seleccione Exportar archivos bilingües. Seleccione 
memoQ XLIFF y haga clic en Exportar. 

3 Abra la vista ToXbench en el editor para que se muestre en la 
cuadrícula de traducción. 

4 En ApSIC Xbench, seleccione Project->Properties, haga clic en 
Add y luego seleccione memoQ File. Agregue el archivo 
ToXbench.mqxlz que creó en el paso 2. 
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Con esta configuración, con la vista ToXbench abierta en memoQ y el 
correspondiente archivo .mqxlz cargado en ApSIC Xbench, seleccione 
Edit Source en ApSIC Xbench para que se posicione en memoQ en el 
mismo segmento que ha seleccionado en Xbench.  

Esto quiere decir que si se detecta un error mientras realiza el control de 
calidad en el archivo de memoQ en Xbench, lo puede arreglar 
directamente en memoQ si selecciona Edit Source (Ctrl+E). 

Instrucciones para 
memoQ 2014 build 51 o 
posterior 

Se agregó una nueva función a memoQ 2014 build 51 que simplifica la 
interoperabilidad con ApSIC Xbench. Desde este build de memoQ, siga 
las siguientes instrucciones para realizar el control de calidad de un 
proyecto de memoQ: 

1 En memoQ, seleccione los documentos, elija Exportar archivos 
bilingües y luego memoQ XLIFF como formato de salida, y haga 
clic en Exportar a una carpeta, por ejemplo ToXbenchQA. 

2 En el explorador de Windows, seleccione el directorio ToXbenchQA, 
haga clic derecho y seleccione Run QA in Xbench, ya que es más 
rápido que usar Project->Properties en ApSIC Xbench. 

3 Ejecute el control de calidad o busque en ApSIC Xbench de la forma 
habitual. Para editar un segmento de memoQ en los resultados del 
control de calidad o de la búsqueda, selecciónelo, haga clic derecho y 
elija Edit Source (Ctrl+E). 
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En esta sección se desarrollan varios temas que ofrecen información 
adicional sobre las características de ApSIC Xbench. 
 

Información adicional 
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Cómo configurar los 
ajustes de ApSIC Xbench 

En el menú Tools, haga clic en Settings para abrir el cuadro de diálogo 
Settings como se muestra a continuación. 

 

En este cuadro de diálogo, se puede configurar ApSIC Xbench para 
iniciar siempre en modo maximizado (recomendado) y, además, cambiar 
las teclas de acceso rápido predeterminadas disponibles en todo el 
sistema. Nota: Cambiar las teclas de acceso rápido predeterminadas sería 
necesario solo como solución alternativa para evitar que entren en 
conflicto con otra aplicación que utilice las mismas teclas. 

Los campos en este diálogo son: 

Maximize on Startup. Al activar esta casilla, ApSIC Xbench aparece 
maximizado cuando se inicia. Se recomienda activar esta casilla, dado 
que el modo maximizado es el que ofrece la máxima cantidad de 
información al mismo tiempo. 

Los siguientes parámetros pertenecen al grupo Hotkeys.  

Disable. Esta casilla permite deshabilitar las combinaciones de teclas 
válidas en todo el sistema que incluye ApSIC Xbench. Se recomienda 
dejar esta casilla desactivada ya que una de las características más 
valiosas de ApSIC Xbench es la capacidad de buscar de manera 
directa desde cualquier aplicación. 

Source Hotkey. Estas son las teclas de acceso rápido asignadas para 
desencadenar una búsqueda del contenido del portapapeles en el texto 
fuente. De manera predeterminada, Ctrl+Alt+Insert. 
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Target Hotkey. Estas son las teclas de acceso rápido asignadas para 
desencadenar una búsqueda inversa del contenido del portapapeles en 
el texto meta. De manera predeterminada, Ctrl+Alt+Retroceso. 

Se recomienda no cambiar la configuración de estas teclas de acceso 
rápido a menos que entren en conflicto con los valores de otra aplicación. 

Internet Search / Open in Default Browser. Cuando está activada, abre 
las búsquedas de Internet en el navegador predeterminado, en lugar de 
abrirlas en el navegador integrado de ApSIC Xbench. 

Transfer Method. ApSIC Xbench utiliza el portapapeles como 
mecanismo de transferencia entre las distintas aplicaciones de Windows y 
ApSIC Xbench. Por lo general, el método de transferencia más 
conveniente y coherente es dejar las opciones predeterminadas Manual 
Copy y Manual Paste, pero en algunos casos (por ejemplo, con 
aplicaciones que no cuentan con la pulsación de teclas para copiar y 
pegar), es posible que se deban cambiar estos parámetros para aprovechar 
ApSIC Xbench al máximo. 

Las opciones disponibles como método de transferencia para Input son: 

Copy Message. Al presionar Ctrl+Alt+Insert, ApSIC Xbench envía un 
mensaje de COPIAR a la aplicación para copiar el texto seleccionado 
en el portapapeles y, luego, realiza una búsqueda utilizando el 
contenido del portapapeles. Un número limitado de aplicaciones son 
compatibles con esta técnica, pero tiene la ventaja de evitar la 
necesidad de copiar de manera manual el texto en el portapapeles (por 
lo general, con Ctrl+Insert). 
Manual Copy. En este modo, ApSIC Xbench espera a que el usuario 
copie el texto a buscar en el portapapeles. Parece más tedioso, pero 
cuenta con la ventaja de que muchas aplicaciones son compatibles 
con la combinación de teclas Ctrl+Insert para copiar texto, lo cual se 
traduce en un comportamiento más coherente entre aplicaciones. 
Como desventaja, si la aplicación de edición tiene un tiempo de 
respuesta muy lento, la combinación Ctrl+Insert o Ctrl+Alt+Insert 
puede resultar muy rápida para la aplicación. 

Keyboard Emulation (Ctrl+Insert). En este modo, ApSIC Xbench 
envía la pulsación de teclas Ctrl+Insert a la aplicación de edición y, 
luego, realiza la búsqueda. De esta manera, el usuario no tiene que 
presionar Ctrl+Insert antes de la búsqueda. Es posible que algunas 
aplicaciones no sean compatibles con este método de entrada. 

Keyboard Emulation (Ctrl+C). En este modo, ApSIC Xbench envía 
la pulsación de teclas Ctrl+C a la aplicación de edición y, luego, 
realiza la búsqueda. De esta manera, el usuario no tiene que presionar 
Ctrl+C antes de la búsqueda. Es posible que algunas aplicaciones no 
sean compatibles con este método de entrada. 

Las opciones disponibles como método de transferencia para Output son: 
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Paste Message. Al presionar Intro para seleccionar una traducción, 
ApSIC Xbench envía un mensaje de PEGAR a la aplicación para 
pegar la traducción. Un número limitado de aplicaciones son 
compatibles con esta técnica, pero tiene la ventaja de evitar la 
necesidad de pegar de manera manual el texto en el portapapeles (por 
lo general, con Mayús+Insert). 
Manual Paste. En este modo, ApSIC Xbench copia el texto meta de 
la entrada seleccionada en el portapapeles si se presiona Intro para 
seleccionar una traducción. Se espera que el usuario presione 
Mayús+Insert (o la combinación de teclas correspondiente para pegar 
texto en la aplicación) para completar la operación de copiar y pegar. 
Este es el modo predeterminado y recomendado por razones de 
coherencia entre aplicaciones. 

Keyboard Emulation. En este modo, ApSIC Xbench envía el texto 
meta simulando que escribe el texto en la aplicación de edición 
cuando se selecciona una entrada y se presiona Intro para copiar la 
selección en el portapapeles. 

Keyboard Emulation (Ctrl+V). En este modo, ApSIC Xbench envía 
el texto meta simulando la pulsación de teclas Ctrl+V en la aplicación 
de edición cuando se selecciona una entrada y se presiona Intro para 
copiar la selección en el portapapeles. 

Haga clic en la pestaña Colors de este cuadro de diálogo para cambiar los 
colores predeterminados de la ventana principal. Aparece la siguiente 
ventana: 

 

Los parámetros de esta pestaña son los siguientes: 

 Background color when zoomed. En ApSIC Xbench, hay dos 
modos: descripción general, en el que se muestran algunas entradas 
de cada nivel de prioridad, y modo zoom, en el que se muestran todas 
las entradas de un nivel de prioridad. Este es el color de fondo que se 
utiliza en el modo zoom, como indicador de que no se está en modo 
de descripción general (el modo predeterminado es el de descripción 
general). 
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 Key Terms Priority. Este es el color que se utiliza para las entradas 
que pertenecen a la prioridad de Términos clave. En Project-
>Settings, se define un glosario como glosario de términos clave. 

 High Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad alta.  

 Medium Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad media. 

 Low Priority. Este es el color que se utiliza para las entradas que 
pertenecen a la prioridad baja. 

 Background color when nothing found. Este es el color de fondo 
que aparece en el cuadro de búsqueda cuando no se encuentra 
ninguna entrada. 

Haga clic en la pestaña Internet para establecer las definiciones de 
Internet: 

 

La pestaña Internet permite definir las URL que se utilizan para realizar 
búsquedas dirigidas en Internet, por ejemplo, en un diccionario. Se 
pueden tener tantas entradas como se deseen, pero solo se asigna una 
tecla de acceso rápido a las 10 primeras, ya sea Alt+n dentro de 
ApSIC Xbench o Ctrl+Alt+n (con el teclado numérico en este último 
caso en modo Bloq Num) desde cualquier aplicación de Windows. n 
puede ser un número del 0 al 9, donde 0 corresponde a la décima entrada 
de la lista. 

Para agregar una nueva entrada, presione la tecla flecha hacia abajo desde 
la última entrada. Para eliminar una entrada, elimine todo el texto de la 
fila.  

Se pueden utilizar los botones Up y Down para desplazar una entrada de 
la lista hacia arriba o hacia abajo. 

Las entradas (hasta 10 con una tecla asignada para cada una) aparecen en 
el menú Internet. 

Puede seleccionar Internet->Capture URL para agregar las URL a esta 
lista. 
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La pestaña Miscellaneous permite especificar distintos parámetros que 
sirven para mejorar la experiencia del usuario a medida que se familiariza 
con ApSIC Xbench. 

 

Los parámetros de esta pestaña son los siguientes: 

 Check Weekly for New Versions. Si esta casilla está activada, 
ApSIC Xbench verifica una vez por semana si hay actualizaciones 
disponibles. 

 Enable Alternative Project. Si esta casilla está activada, 
ApSIC Xbench mantiene en memoria el proyecto abierto antes del 
actual. Para activar uno u otro proyecto, seleccione Project->Switch 
to Alternative Project. Para descartar el proyecto alternativo y 
recuperar la memoria que utiliza, seleccione Project->Forget 
Alternative Project. 

 Load Last Project when ApSIC Xbench Starts. Si esta casilla está 
activada, la próxima vez que se inicie ApSIC Xbench, se carga el 
proyecto que se encontraba abierto en el momento del último cierre. 

 Show Warning when Copying Fuzzy Match. Si esta casilla está 
activada, ApSIC Xbench emite un mensaje de advertencia si, al 
presionar Intro para copiar la entrada actualmente seleccionada en los 
resultados de la búsqueda, la entrada en cuestión no coincide de 
manera exacta con el término buscado. 

 Show Warning when Shutting Down. Si esta casilla está activada, 
ApSIC Xbench emite un mensaje de advertencia al cerrar el 
programa. 

 Show QA Options Changed from Default. Si esta casilla está 
activada, los resultados del control de calidad incluyen en la parte 
superior una lista de todos los parámetros de control de calidad que 
no tienen el valor predeterminado por ApSIC. 

 Match Whole Words in QA Check for Key Terms. Si esta casilla 
está activada, el término meta de una entrada de un glosario definido 
como términos clave debe coincidir con una palabra entera. Se debe 
tener en cuenta que el término fuente siempre coincide con una 
palabra entera. 
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 Show Metadata in Exported QA Reports. Si esta casilla está 
activada, ApSIC Xbench muestra los metadatos del segmento en la 
columna Comments del informe de control de calidad exportado.  

 Default Project Directory. Este campo permite especificar la 
carpeta predeterminada para los proyectos de ApSIC Xbench. 

 Manage Cloud Settings. Este botón le permite configurar qué 
parámetros de Xbench, tales como URL o colores, se deberían 
replicar en la nube para que estén también disponibles en otros 
equipos desde los que inicia sesión con su cuenta de Xbench. 

La pestaña Text Editor permite configurar los argumentos de la línea de 
comandos para un editor de texto cuando se utiliza la función Edit 
Source para los resultados de la búsqueda o del control de calidad en un 
glosario en formato *.txt. Esto incluye archivos delimitados por 
tabulaciones, memorias de Trados exportadas, memorias de 
Wordfast y glosarios de Wordfast. Si se configura de manera adecuada, 
permite abrir el archivo directamente en la línea de donde proviene el 
segmento que se seleccionó mediante Edit Source.  

 

Si opta por definir un editor de texto, se deben asignar valores a los 
siguientes campos: 

 Path to Executable. Esta es la ruta del archivo *.exe del editor de 
texto. Se puede utilizar el botón con puntos suspensivos (...) para 
navegar hasta el archivo *.exe. 

 Command-line Parameters. Este campo sirve para especificar la 
línea de comandos que se debe pasar al editor. Se pueden utilizar 
varias variables que se reemplazan con valores por ApSIC Xbench: 
 $Filename: El nombre del archivo, incluido la ruta del archivo. 

 $Line: El número de línea del segmento en el archivo de texto. 
Esta línea hace referencia al lugar donde está ubicado el texto 
meta. 

 $Column: La columna en la línea donde está ubicado el texto 
meta. 

 $Segment: El número de segmento en el archivo de texto. 
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Por ejemplo, para configurar el posicionamiento de línea en TextPad 
4, se debe seleccionar allí el ejecutable de TextPad y en Command-
line Parameters se debe especificar lo siguiente: 
$filename($line,$column). De manera similar, para configurar 
Notepad++, se debe elegir el ejecutable y en Command-Line 
Parameters se debe especificar lo siguiente: $filename -n$line. Otros 
editores de texto admitirán distintos valores para este campo. 
Consulte la documentación del editor de texto para obtener los 
valores adecuados. 

La pestaña TMX Editor permite configurar los argumentos de la línea de 
comandos para un editor de TMX cuando se utiliza la función Edit 
Source para los resultados de la búsqueda o del control de calidad en un 
glosario en formato *.tmx. Si se configura de manera adecuada, permite 
abrir el archivo directamente en la línea de donde proviene el segmento 
que se seleccionó mediante Edit Source.  

 

Si opta por definir un editor de TMX, se deben asignar valores a los 
siguientes campos: 

 Path to Executable. Esta es la ruta del archivo *.exe del editor de 
texto. Se puede utilizar el botón con puntos suspensivos (...) para 
navegar hasta el archivo *.exe. 

 Command-line Parameters. Estos campos sirven para especificar la 
línea de comandos que se debe pasar al editor. Se pueden utilizar 
varias variables que se reemplazan con valores por ApSIC Xbench: 
 $Filename: El nombre del archivo, incluido la ruta del archivo. 

 $Line: El número de línea del segmento en el archivo de texto. 
Esta línea hace referencia al lugar donde está ubicado el texto 
meta. 

 $Column: La columna en la línea donde está ubicado el texto 
meta. 

 $Segment: El número de segmento en el archivo de texto. 
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Por ejemplo, para configurar el posicionamiento en un segmento en 
OKAPI Olifant, se debe seleccionar allí el ejecutable de Olifant y en 
Command-line Parameters se debe especificar lo siguiente: 
$Filename row=$Segment col=trg edit=yes. Otros editores de TMX 
pueden tener distintos valores para este campo. Consulte la 
documentación del editor de TMX para obtener los valores 
adecuados.  

La pestaña Studio Plugin permite configurar los parámetros que 
modifican el comportamiento del plugin de ApSIC Xbench para SDL 
Trados Studio. 

 

Puede modificar los siguientes parámetros en esta pestaña: 

 Add first local termbase. Cuando esta opción está activada, el 
plugin agrega la primera base de datos terminológica local del 
proyecto de SDL Trados Studio al proyecto de QA de Xbench, que 
crea el plugin. La base de datos terminológica se asignará con 
prioridad alta al proyecto de Xbench. 

 Add first local translation memory. Cuando esta opción está 
activada, el plugin agrega la primera base de datos terminológica 
local del proyecto de SDL Trados Studio al proyecto de QA de 
Xbench, que crea el plugin. La memoria de traducción se asignará 
con prioridad baja al proyecto de Xbench. 

 Use this Xbench project template. Cuando está activada, ordenará 
al plugin que agregue los archivos de Studio al proyecto .xbp de 
Xbench que se indica en el siguiente campo. Utilice el botón con 
puntos suspensivos (...) para abrir el explorador de Windows y 
seleccionar el archivo .xbp. 

La pestaña Transifex le permite configurar el usuario de Transifex que se 
utilizará para recuperar la información del proyecto de Transifex y el 
idioma meta predeterminado. 
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Puede modificar los siguientes elementos en esta pestaña: 

 User Name. El nombre de usuario de Transifex. 
 Password. La contraseña del usuario de Transifex. 
 Test Login. Haga clic en este botón para comprobar que ha escrito 

las credenciales de Transifex correctamente. 
 Default Target Language. Escriba aquí el idioma meta 

predeterminado en los proyectos de Transifex. Si presiona el botón 
con puntos suspensivos (...), se mostrará una lista de idiomas meta 
válidos. 
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Consejos prácticos para 
utilizar ApSIC Xbench 

En este capítulo se presentan las funciones más importantes y una 
descripción general de lo que se puede hacer con ApSIC Xbench. 

Es muy recomendable leer este capítulo para obtener el máximo 
rendimiento de ApSIC Xbench con un mínimo esfuerzo de aprendizaje. 

 ApSIC Xbench no es un indexador, sino que lee el contenido de los 
archivos cada vez que se carga un proyecto e intenta responder 
rápidamente a las búsquedas terminológicas. Por lo tanto, puede 
llevar varios minutos cargar todos los glosarios de Microsoft de un 
idioma principal y, además, se necesita una cantidad significativa de 
memoria. Si se pretende cargar grandes cantidades de material de 
referencia (en el orden de las decenas de millones de palabras), es 
muy recomendable tener, por lo menos, 1 GB de memoria. Si no se 
cuenta con una máquina muy potente, no se recomienda cargar todos 
los glosarios de Microsoft sino una selección más acotada de las áreas 
temáticas que resulten pertinentes al proyecto de traducción actual. 

 Una vez que se carga, ApSIC Xbench permanece activo en un 
segundo plano hasta que se cierra de manera explícita. Cuando 
ApSIC Xbench está activo, aparece una gema rosa en la bandeja del 
sistema. Se debe cerrar ApSIC Xbench para descargarlo de la 
memoria. Por ejemplo, puede cerrarlo si hace clic derecho en el icono 
que está en la bandeja del sistema y selecciona Shut Down Xbench. 

 Mientras ApSIC Xbench esté activo, se puede llamar desde cualquier 
aplicación de Windows con la combinación de teclas Ctrl+Alt+Insert. 
En caso de haber texto marcado en la aplicación, ApSIC Xbench lo 
busca de manera automática. Las pulsaciones de teclas se pueden 
configurar. 

 Además de glosarios de software de Microsoft, ApSIC Xbench es 
compatible con muchos formatos de entrada de varias aplicaciones 
TAO, incluidos Trados, memoQ, Wordfast, Memsource, Matecat, 
SDLX, Transit y otros formatos estándares de la industria como 
TMX, TBX o XLIFF. Se pueden combinar los distintos formatos en 
un proyecto de Xbench asignando prioridades a cada fuente para 
definir el proceso de decisiones terminológicas del proyecto de 
traducción específico. Se puede guardar cada proyecto de 
ApSIC Xbench para su reutilización posterior. 

 Se puede presionar Intro en la ventana principal para copiar el texto 
meta del elemento actualmente seleccionado en el portapapeles. La 
tecla Intro cierra la ventana y copia el texto de modo que se está listo 
para pegarse en la aplicación en la que se edita la traducción con 
Mayús+Insert. Esto resulta muy útil al traducir la documentación de 
una aplicación de software cuyas cadenas de software están cargadas 
en un proyecto de ApSIC Xbench. 
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 Se pueden ejecutar comprobaciones de control de calidad en la 
pestaña QA. Las comprobaciones de control de calidad se ejecutan 
únicamente para archivos definidos como traducción en curso. Una 
función muy avanzada de QA son las listas de comprobación, las 
cuales permiten ejecutar en lote una cantidad de comprobaciones 
predefinidas gracias a la capacidad de búsqueda avanzada de 
ApSIC Xbench. 

Después de adquirir cierta familiaridad con las funciones básicas del 
producto, se recomienda leer la documentación en detalle para aprender 
muchas otras útiles funciones incluidas en el producto. 
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Dónde obtener los 
glosarios de software de 
Microsoft y Apple 

 

Cómo obtener los 
glosarios de Microsoft 

A pesar de que los glosarios de software de Microsoft en formato *.csv 
solían estar a disposición del público desde el servidor FTP de Microsoft, 
en el momento de esta publicación, únicamente se encuentran disponibles 
a través de una suscripción de pago a MSDN. 

Cada idioma tiene su propio archivo *.zip que contiene todos los 
glosarios individuales para los productos de Microsoft localizados en ese 
idioma. El tamaño del archivo para cada idioma puede variar de 1 a más 
de 100 megabytes, lo que depende del número de productos localizados 
por Microsoft en un idioma determinado. 

Cómo obtener los 
glosarios de Apple 

En el momento de esta publicación, los glosarios de software de Apple 
Mac OS X se encuentran disponibles en la siguiente fuente en caso de 
contar con un ID de Apple: 

 http://developer.apple.com/internationalization/downloads/ 

Los glosarios para cada idioma se encuentran en formato de imagen de 
disco para Macintosh (extensión *.dmg). Para cargar los glosarios de 
Mac OS en ApSIC Xbench, se deben extraer los archivos *.ad o *.lg que 
contienen estas imágenes de disco. Para ello, se puede utilizar el software 
UltraISO (http://www.ezbsystems.com/ultraiso/index.html). 
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ApSIC Xbench permite definir vínculos de Internet que se pueden utilizar 
para buscar un término en Internet. ApSIC Xbench cuenta con un sencillo 
navegador integrado, pero presionando Ctrl+B se puede abrir el navegador 
de Internet predeterminado del sistema en la página en la que se está 
navegando actualmente en ApSIC Xbench. 
 

Internet 
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Búsquedas en Internet 
ApSIC Xbench presenta una pestaña Internet que ofrece una ruta de 
integración con algunas fuentes de información y terminología 
disponibles en Internet. En el siguiente ejemplo, se muestra una búsqueda 
en Google efectuada desde ApSIC Xbench. 

 

ApSIC Xbench tiene algunos accesos directos predefinidos, pero el 
usuario puede cambiarlos o definir nuevos vínculos según sea necesario. 
Se puede acceder a los accesos directos definidos mediante alguno de los 
siguientes métodos: 

Vaya a la pestaña Internet, seleccione la fuente deseada en el campo 
Website, escriba la cadena de búsqueda en el campo Text to search y 
presione Intro. 

Con ApSIC Xbench como la aplicación activa, presione Alt+n, donde n 
puede ser cualquier número del 0 al 9. El 0 corresponde a la décima 
entrada de la lista. Para la búsqueda, se utiliza el término actual en el 
campo Source de la pestaña Search o en el campo Text to search de la 
pestaña Internet. El número corresponde al número de secuencia del 
acceso directo en Tools->Settings->Internet. 

Desde cualquier aplicación de Windows, resalte el término buscado y 
presione la combinación de teclas Ctrl+Insert seguida de Ctrl+Alt+n, donde 
el número n debe escribirse en el teclado numérico con Bloq Num 
activado. 
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Definición de accesos 
directos de Internet 

Los accesos directos de Internet se definen en Internet->Define Links. 
Los accesos directos son muy fáciles de definir. Solo siga estos pasos: 

1 Abra la lista de accesos directos en Internet->Define Links. Para 
crear una nueva entrada, simplemente hay que desplazar el cursor 
hacia abajo, más allá de la última entrada, con las teclas de dirección.  

 
2 Efectúe una búsqueda en la fuente del sitio web que desea comprobar. 

Por ejemplo, realice una búsqueda de un término en Google (por ej., 
«xbench»). 

3 Copie la URL en el portapapeles; la URL puede, por ejemplo, verse 
como la siguiente: 

http://www.google.com/search?hl=en&lr=&ie=UTF-8&q=xbench 

4 Pegue la URL en una entrada de la ventana y reemplace el término 
que buscó con %s como se ve en el ejemplo. En búsquedas futuras 
que utilizan esta cadena de consulta, ApSIC Xbench reemplaza la 
secuencia %s con la cadena de búsqueda. 

5 Asigne un nombre al acceso directo: mueva el cursor a la columna 
Name y escriba el nombre allí. Este nombre aparece en el campo 
Website de la pestaña Internet y también en el menú desplegable 
Internet. 

6 Si se desea desplazar la entrada actual hacia abajo en la lista (lo cual 
tiene el efecto de cambiar el número de tecla de acceso rápido), se 
puede hacer clic en los botones Up y Down ubicados en la parte 
inferior de la ventana. 
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Si encuentra un vínculo interesante mientras explora una página 
utilizando la pestaña Internet de ApSIC Xbench, puede agregarlo 
rápidamente a la lista de páginas con el elemento de menú Internet-
>Capture URL. 

Si se tiene la barra de herramientas activada, aparecen varios botones que 
ayudan a navegar por las páginas de Internet. Uno de estos botones 
permite abrir Internet Explorer en la misma página que se está 
visualizando. Esto también se puede hacer con el menú Internet->Open 
Browser o con la combinación de teclas Ctrl+B. 
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Errores y sugerencias 
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Cómo informar acerca de 
errores y hacer 
sugerencias 

Sus comentarios respecto a errores en el programa son más que 
bienvenidos. También aceptamos sugerencias sobre cómo mejorar ciertas 
áreas que puedan parecer confusas.  

Envíe un informe de errores o sus sugerencias a 
http://www.xbench.net/index.php/support/submit-bug. 

Cualquier información que envíe será tratada confidencialmente y se 
utilizará únicamente para resolver el problema. 
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